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About This Manual
Thank you for purchasing the Goldenseal small business software! It will
help you to run your business more profitably.

This start up manual shows you how to get started with the accounting,
payroll, job cost and rental management features in Goldenseal.

It includes the following sections:

Tutorial— A series of lessons that explain Goldenseal’s basic features.
Getting Started On Your Own— How to prepare Goldenseal to fit your

business.

This manual is a companion to the Getting Started With Goldenseal
Estimating manual. It’s a good idea to look at the first few lessons in the
Estimating manual first, since they contain information about many basic
Goldenseal features which are also used in the accounting parts of the
program.

HINT: Page Numbers in this manual start at 201, and the Lessons start
at 30— even though the Estimating manual has fewer pages/lessons.
That way we can expand the Estimating Manual without redoing this
manual.

The index for this manual is in the rear of the Estimating manual— the
index covers both manuals together.

Getting Help
Goldenseal includes unlimited free email and telephone support for as long
as you use the software. Send email to support@turtlesoft.com, or call us at
(607) 272-1008 during our office hours (currently M-F 9-6 Eastern time).

We also offer many support options on our website at www.turtlesoft.com.
Click the Site Map button to see a list of 'special topics', where we have
specific instructions for many situations.

HINT: It is much easier for us to keep the website up to date, so new
features are often described there before we can get them into the
printed manuals.
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Lesson Thirty: Chart of Accounts
Goldenseal uses accounts to keep track of each person and company with
whom you do business. Before you start to use Goldenseal, you'll create
accounts for everyone who pays you money (jobs) and everyone that you
pay money to (costs).

The Chart of Accounts lets you see all of your accounts in a convenient
graphic format.

Opening the Chart of Accounts
Before you begin this tutorial, open the Sample Company File or another
Goldenseal file that already contains some accounts (see Lesson 1).

To open the Chart of Accounts window, follow these steps:

1. Choose Chart of Accounts from the View menu.

You can scroll each column individually to see the accounts in that column.

• To move up in the list, click on the ‘up’ arrow to the right of the
column.

• To move down in the list, click on the ‘down’ arrow.
• To move quickly to a different part of the account list, click on the

movable ‘thumb’ box and drag it up or down.

Moving and Resizing the Window2. A submenu will appear. Choose Show Window from the submenu,
then lift up the mouse button. To move the Chart of Accounts window to a different part of your screen,

click in the title bar at the top of the window and drag to a new location.
You’ll use the same approach to move any window.

3. The Chart of Accounts window will appear on the screen.

Viewing Accounts To change the size of the Chart of Accounts window (or any window), click
on any corner of the window border and drag it to a new size.

There are four basic groups of accounts— Jobs, Assets, Liabilities and
Costs. Each of the four columns in the Chart of Accounts shows one
account group (for example, the Assets column shows cash, checking,
equipment, inventory, investment, real estate and savings accounts).
Goldenseal uses different icons for each class of accounts.

HINT: You can also click on any part of the window border and drag to
resize.

You can also 'zoom' the window to full size by clicking the zoom button
(the middle button of the three window controls at the upper right corner).
Click the zoom button again to return to the original size and position.HINT:  Lesson 31 will cover the specific types of accounts.
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Closing the Window Icon Size
To close the Chart of Accounts window, choose Close Window from the
File menu. This command also closes any other Goldenseal window.

Goldenseal lets you use large icons if a column doesn’t include many
accounts, or smaller icons if you’d like to see more accounts in the window.

You can also click in the Close box (the X at the upper right corner) to close
any window.

To change the size of the icons in the Chart of Accounts window, follow
these steps:

Docking the Window
1. Click anywhere in the column you’d like to change. You can select an

icon, or click on the column title.
2. Choose Chart of Accounts from the View menu, then choose Icon Size

from the submenu.Click on the docking button at the upper right corner (the left-most of the
three window controls) to ‘dock’ any Goldenseal window. It will compress
into a small rectangle at the bottom of the screen. Double-click on a docked
window to restore it to full size.

Sorting Order
To change the ordering of accounts in any column of the Chart of Accounts,
follow these steps:

1. Click anywhere in the column you’d like to change. You can select an
icon, or click on the column title.

2. Choose Chart of Accounts from the View menu, then choose Icon
Order from the submenu.

3. Choose the sorting order that you’d like to use.

You can use any of the following sorting orders:

• Reverse Order takes the current sorting order and reverses it. For
example, reversing By Size puts the smallest accounts at the top. 3. Choose Large Icon, Small Icon or No Icon from the second submenu.

Finishing Up

• Custom Order remembers the position of each account, even if you
drag it to a new position in the list.

• By Name puts the accounts into alphabetical order.
This lesson has explained how to use the Chart of Accounts.• By Size puts the accounts with the largest balance at the top.
Coming up is more about the accounts that are behind those pretty
pictures. But before you start on that, maybe it’s time to take a shower and
sing all the songs you know about accounting and business management.

• By Kind groups accounts by class.
• By Times Used puts the most frequently used accounts at the top.
• By Creation Date puts the newest accounts at the top.

HINT: If you play guitar, you probably shouldn’t play it in the shower.
Especially if it’s an electric guitar.

• By Last Revised Date puts recently changed accounts at the top.
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Lesson Thirty-One: Accounts Investments— Use investment accounts for any assets that don’t fit
into one of the other classes (see page 215).

Real Estate— Use real estate accounts for buildings and land that you
own or manage (see page 216).

This lesson covers Goldenseal accounts. Goldenseal uses accounts for
customers, employees, bank accounts, and other “real world” people,
businesses and financial entities. Savings— Using savings accounts for bank accounts that don’t use

sequential check numbers (see page 217).
There are four basic types of accounts— jobs, assets, liabilities and costs.

Job Accounts Liability Accounts
Job accounts consume expenses, and create income (directly or indirectly).
When you track job costs, you’ll assign every expense to a job account.

Asset accounts are for money that you owe to others, or for money that you
manage on their behalf.

There are three classes of job accounts: There are four classes of liability accounts:
Customers— Use customer accounts for people or businesses that give

you money for the goods or services that you provide to them (see
Lesson 9).

Credit Cards— Use credit card accounts for ‘revolving’ credit cards or
credit lines that you can draw on or use for purchases (see page 218).

Escrows— Use escrow accounts for money that you manage for others.
Escrow accounts don’t show up on your balance sheet (see page 219).Overhead accounts— Use overhead accounts to allocate your cost of

doing business. Overhead accounts handle any expenses that can’t be
assigned to a specific customer or project (see page 210).

Loans— Use loan accounts for mortgages, notes, and other debts (see
page 220).

Projects— Use project accounts for pieces of work that you do for a
customer, or as part of your overhead (see Lesson 9).

Owner Equity— Use owner equity accounts to track ownership of your
business. In accounting terms, equity is a liability since you ‘owe’ it to
the owners (see page 221).HINT:  When you enter job costs for maintenance expenses, you can

also use Equipment, Investment and Real Estate accounts as jobs,
even though they are primarily listed as assets.

Cost Accounts

Asset Accounts Cost accounts are for people or businesses that you pay for expenses.

There are five classes of cost accounts:Asset accounts are for items that you own that have value.
Employees— Use employee accounts for each person that receives

wages from you (see pages 222-223).There are seven classes of asset accounts:

Cash— Use cash accounts for cash registers, cash drawers, petty cash
and money hidden in mattresses (see page 211).

Equipment— Use equipment accounts for machinery, vehicles, large
tools, computers and similar items. Equipment is considered as both
an asset and as a cost account (see page 224-225).Checking— Use checking accounts for bank accounts that you can draw

on by writing sequential checks (see pages 212-213). Material Suppliers— Use material accounts for anyone who provides
you with tangible materials or supplies (see page 226).Equipment— Use equipment accounts for machinery, vehicles, large

tools, computers and similar items. Equipment is considered as both
an asset and as a cost account (see pages 224-225).

Subcontractors— Use subcontractor accounts for anyone who provides
you with services but who isn’t on your payroll (see pages 227-228).

Inventory— Use inventory accounts for materials that you store for
retail sales or for use in projects (see page 214).

Other Costs— Use other cost accounts for vendors who don’t fit into
one of the other cost account classes (see pages 228-229).
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Overhead Accounts Cash Accounts
Use Overhead accounts to track expenses that you can’t assign to a
specific customer or project.

Use Cash accounts for currency, traveler’s checks and other cash items that
you keep in cash registers, cash drawers, or petty cash accounts. You can
create a separate account for each location where cash is kept.You only need one overhead account, but you can create more Overhead

accounts if you’d like to track different types of overhead separately. To create a new cash account, follow these steps:

To create a new overhead account, follow these steps: 1. Choose Cash from the Accounts menu.

1. Choose Overhead from the Accounts menu.

2. You’ll see a browser window (see Lesson 2).
3. Click the New button.
4. Enter a short account name.
5. Enter an address.
6. Enter the starting balance, and the minimum balance you’ll maintain.
7. Enter the Company Division in which to include this asset.

2. You’ll see a browser window (see Lesson 2). 8. Enter any comments you have about this account.
3. Click the New button.

Using Cash Accounts4. Enter a short account name.
5. If you’d like to track overhead expenses against a budget, enter an

estimate into the Job Cost Budget field. When you use cash to make a purchase, enter a Material Purchase, enter
Cash as a payment method and enter the cash account for an ‘instant
purchase’ transaction (see page 242).6. Fill in the other fields (see the Reference Manual for details, or look at

the help messages in the left side of the window).
To transfer money in or out of a cash account, use Cash Transactions (see
page 270). To deposit money from a cash register or cash box, use the
Deposit Funds command (see Lesson 44).
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Checking Accounts Using Checking Accounts
When you make a purchase and pay by check, enter a Material Purchase,
enter Checking as a payment method and enter the checking account for an
‘instant purchase’ transaction (see page 242).

Use Checking accounts for bank accounts that include sequential checks
that draw on your funds. Checking accounts will probably be your busiest
accounts.

To pay multiple bills by check, use the Pay Bills command (see Lesson 36).To create a new checking account, follow these steps:
To write paychecks, use the Write Payroll command (see Lesson 46).1. Choose Checking from the Accounts menu.

To transfer money in or out of a checking account, use Checking
Transactions (see pages 261-272).

To deposit money from a cash register or cash box, use the Deposit Funds
command (see Lesson 44).

Multiple Checkbooks
Each checking account can include one or more checkbooks. Each time you
write a check, you can choose which checkbook to use for the payment.

To add a new checkbook to a checking account, follow these steps:

1. Choose Checking from the Accounts menu, and find the account you’d
like to change.

2. Click anywhere in the last checkbook row in the checkbook table (at
the right side of the window).

3. Press the Return key to add a new row.
4. Enter a new checkbook name, and the next available check number for

that checkbook.
5. Repeat steps 3 and 4 for each additional checkbook in the account.

To change the next number for a checkbook, click in the Next # cell and
type in a new number.

2. You’ll see a browser window (see Lesson 2).
3. Click the New button.

HINT: You may need to change the check number if you void a check,
lose a checkbook, or otherwise get a mismatch between the next check
number in Goldenseal and your actual checkbook.

4. Enter a short account name (for use in menus), and the full account
name (for printed forms).

5. Enter an address, phone and account number. Then enter the starting
balance, and the minimum balance you want to maintain.

Using Checkbooks6. Enter the company division in which to include this asset.
When you use the Write Payroll or Pay Bills commands, Goldenseal will
ask you which checkbook to use for the payment .

HINT: To change the list of company divisions, click on the popup
button next to the clairvoyant field, then choose Edit Company
Divisions from the bottom of the menu. To use a checkbook when you enter a check transaction directly, choose a

checkbook from the Checkbook popup menu (see Lesson 37).7. Use the checkbook table to enter each checkbook that draws on this
account. For each checkbook, enter the next available check number.
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Inventory Accounts Investment Accounts
Use Inventory accounts to keep track of goods that you store for while
before you sell them or use them in projects (see Lesson 47).

Use Investment accounts for any assets that don’t fit into one of the other
categories.

To create a new inventory account, follow these steps: To create a new Investment account, follow these steps:

1. Choose Inventory from the Accounts menu. 1. Choose Investments from the Accounts menu.

2. You’ll see a browser window (see Lesson 2).
3. Click the New button.
4. Enter a short account name .

2. You’ll see a browser window (see Lesson 2).5. Choose the way you’d like to value the inventory in this account, and
how items in the account should be aged. 3. Click the New button.

6. Fill in the other fields (see the Reference Manual for details). 4. Enter a short account name (for use in menus), and the full account
name (for printed forms).

Using Inventory Accounts 5. Enter an address, phone and account number. Then enter the starting
balance, and the minimum balance you want to maintain.When you buy materials for inventory, create a Material Purchase trans-

action, and enter an inventory account as the Job account (see page 240). 6. Fill in the other fields (see the Reference Manual for details, or look at
the help messages in the left side of the window).

When you sell items from inventory, enter the inventory account into the
Sales transaction (see page 192).

Using Investment Accounts
When you use inventory items in a project, create an Inventory Used
transaction for the account (see page 252).

To transfer money in or out of an investment account, use Investment
Transactions (see page 270).

To adjust inventory quantities or value, create an Inventory Transfer for the
items (see page 352).
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Real Estate Accounts Using Real Estate Accounts
When you enter expenses for a property, enter a Real Estate account into
the Job field (see page 240).

Use Real Estate accounts for property that you own or manage (see Lesson
41 for more about rental management).

Enter Leases for tenants who rent (see page 295), and enter Rental
Transactions for the rent that they owe (see page 296).

To create a Real Estate account, follow these steps:

1. Choose Real Estate from the Accounts menu.
To create rental bills, choose Billing from the Income menu, and choose
Rentals from the submenu (see page 300).

2. Click the New button.
3. Enter information about the property (see the Reference Manual for

details, or look at the help messages in the left side of the window).
Savings Accounts

To create a new Savings account, follow these steps:

1. Choose Savings from the Accounts menu.

More Setup Button
Click the More Setup button to enter depreciation, job costing and property
management info for each property. 2. You’ll see a browser window (see Lesson 2).

3. Click the New button.
The button opens a separate dialog window where you can view and enter
additional info. Click OK to save changes, or click Cancel to return to the
main window without saving changes.

4. Enter a short account name.
5. Fill in the other fields (see the Reference Manual for details, or look at

the help messages in the left side of the window).

Rental Units Using Savings Accounts
Each rental property can contain one or more rental units. To add rental
units, click the Add Rental Unit button. To transfer money in or out of an savings account, use Savings Transactions

(see page 270).
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Credit Card Accounts Escrow Accounts
Use Credit Card accounts for credit cards and similar ‘revolving’ lines of
credit that you can draw on at any time.

Use Escrow accounts for money that you manage on behalf of someone
else.

NOTE: Don’t create a separate account for debit cards. They can draw
directly from the Checking or Savings account that provides funds.

To create a new Escrow account, follow these steps:

1. Choose Escrows from the Accounts menu.
To create a new Credit Card account, follow these steps:

1. Choose Credit Cards from the Accounts menu.

2. You’ll see a browser window (see Lesson 2).
3. Click the New button.2. Click the New button.
4. Enter a short account name (for use in menus), and the full account

name (for printed forms).
3. Enter a short account name (for use in menus), and a full account

name (for printed forms).
5. Fill in the other fields (see the Reference Manual for details).4. Fill in the other fields (see the Reference Manual for details).
6. You can enter multiple checkbooks into each escrow account (see page

213).Using Credit Card Accounts
When you make a purchase and pay by credit card, enter a Material
Purchase, enter Credit Card as a payment method and enter the credit card
account for an ‘instant purchase’ transaction (see page 242).

Using Escrow Accounts
To transfer money in or out of an escrow account, use Escrow Transactions
(see page 270).To transfer money in or out of a credit card account, use Credit Card

Transactions (see page 270).
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Loan Accounts Owner Equity Accounts
Use Loan accounts for any loans that aren’t credit cards. Use Owner Equity accounts to track ownership of your business.

To create a new Loan account, follow these steps: HINT: You probably need only one owner equity account, even if there
are multiple owners.1. Choose Loans from the Accounts menu.

To create a new Owner Equity account, follow these steps:

1. Choose Owner Equity from the Accounts menu.

2. You’ll see a browser window (see Lesson 2).
3. Click the New button.2. You’ll see a browser window (see Lesson 2).
4. Enter a short account name (for use in menus), and the full account

name (for printed forms).3. Click the New button.
4. Fill in the data fields (see the Reference Manual for details). 5. Enter an address, phone and account number. Then enter the starting

balance, and the minimum balance you want to maintain.5. You can enter multiple checkbooks into each loan account (see page
213).

6. Click the More Details button to enter additional info about the loan.

Using Loan Accounts
To transfer money in or out of a loan account, use Loan Transactions (see
page 270).
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Employee Accounts 8. Click the Payroll Setup button to enter the employees usual wage rate,
tax withholding, benefits and vacations.Employee accounts store information about each employee.
HINT: For more about payroll setup, see Lesson 45. For instructions
on importing your state's payroll tax tables, see page 396.

To enter payroll information for an employee, follow these steps:

1. Choose Employees from the Accounts menu.
2. Click the New button. 9. Click the Contact Info button to enter the employee's phone, address

and other contact info.3. Enter a brief name for the employee. It will appear in the Chart of
Accounts and in popup menus. Also enter a job title and the
employee’s full name (for use on printed checks). Using Employee Accounts

4. Enter the employee’s address, phone, e-mail address and tax
identification number. You can also enter an emergency contact
person, hiring and termination dates, and any comments you have.

To track the work done by each employee, enter Labor Hours (see page
338). To write paychecks, use the Write Payroll command (see page 342).
Goldenseal stores payroll information for each employee in Payroll Records
(see page 345).5. Enter a cost grouping for the employee in the Cost Type field. This is

just a convenient way to classify and group your employees.
To see contact records for an employee, click the View Appointments
button, or one of the other action buttons (see page 15).

6. Enter the time and materials billing rate that is used for this employee
(see page 329). If the billing rate uses a variable amount, enter the
amount that is used for this employee.

7. Enter the billing rate and the optional billing amount that is used to
calculate job costs for this employee.
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Equipment Accounts
Create equipment accounts for equipment, vehicles, large tools, machinery
and similar productive items that you own or lease. You can also use them
for livestock, intellectual property or other productive units.

To create an Equipment account, follow these steps: 10. Set up depreciation info in the fields on the left, and project billing
info in the fields on the right, then click OK to save changes.1. Choose Equipment from the Accounts menu.

2. Click the New button. HINT:  To see more info about the fields, put the mouse cursor over a
field and read the help info at the bottom of the window.3. Enter an account name for use within Goldenseal, and a full name for

printed forms.
Using Equipment Accounts4. Enter the employee who usually uses the equipment, and any

comments you have about this equipment. To track the time that you use equipment, enter Equipment Hours (see page
251).  Goldenseal applies the equipment expense to time and materials
billing (see Lesson 43) and to job costs (see Lesson 39).

5. Enter the places where you’d like to display this account in the Chart
of Accounts.

6. Enter the company division to which this item belongs. When you spend money on equipment, create an expense transaction and
enter the equipment into the Job field (see page 240). That way you can
track maintenance costs for each piece of equipment.

7. Enter a cost grouping for the equipment in the Cost Type field. This is
just a convenient way to classify and group your cost accounts.

8. Enter the category system you’ll use when entering expenses for this
account. You can also enter an estimate to use for a job cost budget. NOTE: Equipment is a cost account when you use it for work on

projects, and an honorary job account when you need to repair it.
9. To enter billing and depreciation info for this account, click the More

Info button. Goldenseal includes the value of your equipment as an asset on the Balance
Sheet (see page 382).
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Material Accounts Subcontractor Accounts
Before you start to enter material purchases, create a Material account for
each supplier that provides you with any type of tangible goods. Use
material accounts for those who provide construction components, office
supplies or raw materials. You can also use them for anyone from whom
you buy equipment or real estate properties.

Create a Subcontractor account for each person or business that provides
professional services to you. To enter subcontractors, follow these steps:

1. Choose Subcontractors from the Accounts menu.

To create a Material account, follow these steps:

1. Choose Material Suppliers from the Accounts menu,.
2. Click the New button.

2. Enter an account name and other contact info.
3. Click the Billing Setup button, and enter billing info for this account.
4. Click the Insurance Setup button, and enter insurance expiration

dates, and how you’ll handle expired insurance (see page 259).

3. Fill in the data fields (see the Reference Manual for details).
4. Click the Billing Setup button to enter additional billing and job

costing info for this account.

Using Material Accounts
To enter purchases, choose Material Purchases from the Costs menu (see
Lesson 33).

To pay invoices, choose Pay Bills from the Bank menu (see Lesson 36).
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Other Cost Accounts
If you pay money to someone and they aren’t a material supplier or
subcontractor, enter them as an Other Cost account. Use Other Cost
accounts for government and tax agencies, and for those who provide you
with intangible services such as advertising, insurance, lodging, mailing,
printing, shipping, travel and utilities.

HINT: Some accounts might fit into any of the three types of cost
accounts (material supplier, subcontractor or other cost account).  In
that case it's just a matter of personal preference where you put them.

To create an Other Cost account, follow these steps:

1. Choose Other Costs from the Accounts menu.

6. Enter the category system to use for this vendor’s expense, the way
you’ll classify expenses for this vendor in the income tax report, and
whether they get a 1099 form.

7. Click OK to save the billing setup.

Using Other Cost Accounts
To enter other cost transactions, choose Other Costs from the Costs menu
(see page 255).

To pay invoices, choose Pay Bills from the Bank menu (see Lesson 36).

You can create one or more Other Cost account to cover ‘one time’ vendors
who don’t need their own separate account.

Finishing Up
In this lesson you have learned how to work with accounts.

Before you move on, you may want to take a break. Relax, lie on your back
and put your feet up. Can you wiggle your ears? Can you make the sound
of one hand clapping? Can you make the sound of one ear wiggling?

2. Click the New button.
3. Enter an account name and contact information for the account.

FACT FOR THE DAY: Article 151, Subchapter 14.240-b of the US Tax
Code requires all IRS auditors to be able to wiggle their ears by at least
1/4 inch (6 mm). It’s considered useful for intimidating those being
audited, and it’s entertaining for co-workers.

4. Click the Billing Setup button, and enter basic billing info.
5. Enter the payment terms you use for this vendor, vendor withholding

(such as GST credits), your credit limit with this vendor and the sales
tax rate you pay.
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Lesson Thirty-Two: Lists Using List Items
To use a list item, enter it into a clairvoyant field. For example, to give a
material supplier a different set of payment terms, follow these steps:Goldenseal uses lists for many of the details of running your business.

1. Choose Material Suppliers from the Accounts menu.This lesson covers several basic lists— for payment terms, prospect
sources, depreciation, billing rates and delivery charges. 2. Click the Billing Setup button.

3. Enter the new terms into the Payment Terms clairvoyant field (see
Lesson 2 for more about clairvoyant fields).

Viewing Lists
You can also use the popup button in the clairvoyant field to see list items.

To view lists, use the menu commands at the top of the screen.
• Choose Edit Vendor Payment Terms to see the whole list of terms.

For example, to see the list of vendor payment terms, follow these steps: • Choose View This Vendor Payment Term to see the current terms.
1. Choose Payment Terms from the Options menu, then choose Vendors

from the submenu. Vendor Payment Terms
2. You will see a list of all the current payment terms.

Use Vendor payment terms to set the way you pay for billed materials,
subcontractors and other costs. To enter terms, follow these steps:

1. Choose Payment Terms from the Options menu, then choose Vendors
from the submenu.

2. You’ll see a list of payment terms for vendors.
3. Select an item and click the Edit button, or click the New button to

enter new terms.

Entering List Items
To change a set of payment terms, double-click on an item in the list, or
click once on an item and then click the Edit button.

To create new terms, click the New button.

To copy existing terms, click once on an item and click Duplicate.

To delete an unused set of terms, click once on an item and click Delete.

To sort the list into alphabetical order, click the Sort button.

When you are finished with the list, click the Done button.
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4. Enter values into the fields. For example, to change the text that
Goldenseal prints on each customer’s billing statements, change the
text in the Form Message field.

Prospect Sources
Use the Source field in the customer account to enter the way a customer
first heard about you. To enter Prospect Sources, follow these steps:

HINT: Check the Reference Manual on the CD for more about the
specific fields in this window. 1. Choose Income Setup from the Income menu, then choose Prospect

Sources from the submenu.
5. To save any changes that you have made, click the OK button. To

leave without saving changes, click the Cancel button.

Customer Payment Terms
Use Customer Payment Terms to set up your billing frequency, early-
payment discounts and finance charges for billed sales.

To modify a set of customer payment terms, follow these steps:

1. Choose Payment Terms from the Options menu, then choose
Customers from the submenu.

2. In the list of payment terms, double-click on the payment terms item
you’d like to change, or click the New button to make a new set of
payment terms.

2. You’ll see a list of possible sources.
3. To add a new item, click the New button. Prospect Sources are a

simple list of names, so Goldenseal will add the new item directly to
the list, instead of showing you a separate dialog box.

4. Type the new name directly into the list.
5. To change an existing item, double-click on it (or click on the name,

then click Edit). You can change its name directly in the list.

More Simple Lists
Goldenseal includes several other simple lists. Choose Other Lists from the
Options menu, and enter any of the following:

Actions Taken— things you’ve done for problems, contacts and
documents.

Appointment Type— types of appointments for Appointment records.
Contact Type— types of meetings and calls for the Contact Log.
Document Type— types of documents for the Document Log
Problem Type— types of problems for the Problem Log.
Tools— simple tools that you use in projects.

3. Enter values into the fields, then click the OK button. Unit Sizes— sizes for Cost Items and Assemblies (e.g. square feet).
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Depreciation Methods
Depreciation Methods calculate depreciation for Real Estate and
Equipment accounts. To enter depreciation methods, follow these steps:

1. Choose Cost Setup from the Costs menu, then choose Depreciation
Methods from the submenu.

2. You’ll see a list of methods. Click the New button.
3. Enter a brief name for the depreciation method
4. Enter any comments you have about this method.
5. Enter the way you’ll calculate depreciation for this item (see the

Reference manual for details).

Billing Rates
Use billing rates to set the amount you charge for time-and-materials work
and job costs. There are separate rates for equipment, labor and subs.

To enter Equipment Billing Rates, follow these steps:

1. Choose Billing Rates from the Options menu, and choose Equipment
from the submenu.

2. Click the New button, or select an existing item and click Edit.
3. Enter a brief name for the rate, and any comments you have about it.

6. Most calculation methods fill in a depreciation table at right. You can
scroll through the years to see the amount of depreciation each year.
For a Custom calculation method, enter percentages into the table.

Reconcile Periods
Use Reconcile Periods to mark off bank transactions when you reconcile an
account against the bank statement (see page 277). To enter reconcile
periods, follow these steps:

1. Choose Other Lists from the Options menu, then choose Reconcile
Periods from the submenu.

4. Enter the way you’d like to calculate the rate.2. You’ll see a list of periods. Click the New button.
5. Enter an Overhead account to use for this rate.3. Enter a brief name, any comments you have, and a date for the period.
6. When you are finished, click the OK button.4. Click OK.
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Delivery Methods 7. Enter a charge into the Charge column in the first row.
8. If the charge applies only up to a certain weight or amount, enter the

cutoff amount into the Up To column.
The Delivery Methods list identifies shipping and delivery methods for
sales transactions. It calculates any charges that you’ll make for shipping or
deliveries. The list uses a table of values, so you can charge different
amounts based on the price or weight of the order.

9. When there is only one charge for all items, you’ll only need one row. If
there are different charges for different price ranges or weight ranges,
press the Return key to enter another row.

To enter a delivery method, follow these steps: HINT: New rows always have a From value that is equal to the
previous row’s Up To value. Goldenseal does not let you enter Up
To values that are not in ascending order.

1. Choose Income Setup from the Income menu, then choose Delivery
Methods from the submenu.

2. You’ll see a list of delivery methods. Select a method, and click the
Edit button (or click the New button to create a new method).

10. Repeat steps 7 to 9 as many times as you need.
11. When you are finished, click the OK button.

3. Enter a brief name, and any comments you have about this item. 12. To leave the list of job sales taxes, click the Done button.

Finishing Up
There are about 60 lists used within Goldenseal, but they all look similar to
one of the lists we have already covered in this lesson.  You only need to
use those lists that make sense for your business.

HINT: A starter company file already comes with many lists filled in
(see page 159).

If you’d like to look at other lists, choose a submenu from any of the fol-
lowing menu commands:

Income menu— Income Setup
Costs menu— Cost Setup or Payroll Setup
Options menu— Account Groups, Billing Rates, Contract Setup, Payment

Terms, Calculations or Other Lists

Before you move on, it’s definitely time to take a break. What would hap-
pen if you were called on to sing the Star Spangled Banner at baseball
opening day, and the President of the United States were there? This might
be a good time to learn the second verse.

HISTORY FACT FOR THE DAY: The writer of the national anthem,
Francis Scott Key, also invented the shower. His first version was used
only for singing in, but he added plumbing after his wife threatened to
convert the space to chic hat storage.

4. Click on the first checkbox to determine whether sales tax is based on
the customer’s usual tax rate or the tax rate for the Sales Branch (use
the latter for sales that are not delivered). Click on the second
checkbox to determine whether delivery charges are taxable.

ANOTHER HISTORY FACT FOR THE DAY: Mrs. Scott Key is famous
in her own right, since she invented the pink yard flamingo (along with
her best friend Mae West). Residents of Florida were so grateful to them
that they named Key West in their mutual honor.

5. Choose the text to fill into the address field in Sales.
6. Choose the calculation method for the delivery charge. It can be based

on the weight or the sale price. It can be calculated as a percentage of
the sale price, or as a flat dollar amount.
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Lesson Thirty-Three:
Material Purchases

6. Press the Tab key, and type the purchase price into the Gross Price
field.

7. When you enter a vendor, Goldenseal automatically enters their usual
tax rate. If for some reason you will pay a different rate for this pur-
chase, enter it into the Tax Rate field.Whenever you buy supplies or materials, enter the expense into a material

purchase transaction. Material purchases are one of the five classes of
expense transactions. The others are equipment hours, subcontractor costs
and other costs (Lesson 35) and labor hours (Lesson 46).

HINT: To see the usual tax rate for this supplier, choose Main
Account from the View menu, and look at the Sales Tax Rate field.

8. Press the Tab key until the Invoice field is selected, then type in the
vendor invoice number (if any). Notice that Goldenseal automatically
computes the net price and sales tax amount when you leave the
Gross Price field.

This lesson shows you how to enter a simple purchase for a single material
item.

NOTE: Lesson 34 shows you how to enter multiple items in a purchase.
9. Press the Tab key, and enter any comments you have.

Entering Purchases
To enter a simple material purchase for one item, follow these steps:

1. Choose Material Purchases from the Costs menu.
2. Click the New button.

10. To finish the purchase transaction, assign job costs, apply any special
conditions or linked transactions, and enter a payment method (see
the next 3 pages for further details).

11. Choose Save Record from the Edit menu to save the transaction.

3. You will see a blank purchase record.
4. Click in the Supplier field, and start typing the supplier’s name until

the correct account has been selected (see page 15).
HINT: You can also click on the popup button next to the Supplier
clairvoyant field, and choose an account.

5. Press the Tab key, and type in a brief description of the purchase.
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Job Cost Information To enter cost category info, follow these steps:

Goldenseal allows you to assign every expense to a job (which can be a
customer, a project, or an overhead account). You can also allocate costs to
cost categories and locations. Entering job cost information is the best way
to track your expenses, so you can understand how the money is spent in
your business.

1. Click in the Category field, and choose a cost category.
NOTE: If no category is available, it’s because the selected supplier
uses a category system that has no categories in it.

2. Press Tab or click in the Subcategory field, and choose a job cost sub-
category.

HINT: If you are only entering a purchase for the sake of job costing
and don’t want to track payments for it, enter Job Cost Only into the
Status field. This feature is especially useful if you are entering old
invoices when you first set up Goldenseal (see page 400).

NOTE: Some category systems don’t include subcategories. If that is
the case, just leave the field blank.

3. Press Tab or click in the Location field, and enter the location where
this purchase is used.

Jobs Special Conditions
A job is any part of your business that consumes expenses. Some jobs cre-
ate income directly. Other jobs don’t create income, but are allocated as
indirect expenses (overhead, equipment, inventory and real estate).

Some purchases have special conditions— they apply to another transac-
tion, or receive special treatment in expense accounting. To enter a special
condition, choose an item in the Applies To field.

Assign material purchases to any of the following job classes: When this expense applies to another transaction, enter the linked
transaction into the Transaction field. The following choices work that way:Customer— items you buy for resale directly to a specific customer.

Project— materials and supplies used in a project. Allowance— project purchases that apply to an allowance. Goldenseal
will include this item when you do Allowance billing.Overhead— materials and supplies for the office.

HINT: If it doesn’t make sense to assign a cost to any other job type,
use an Overhead account.

Bid— purchases that apply to a prior bid from this vendor. Goldenseal
warns you if the total amount of purchases exceeds the bid amount.

Inventory— materials purchased and kept in inventory for later resale. Change Order— project purchases that apply to a change order.
Goldenseal will include this item when you do Change Order billing.Equipment— materials used for equipment repair, or supplies consumed

by a piece of equipment as part of its productive use. Purchase Order— this purchase will be applied to a prior purchase order
for this vendor. When you complete the transaction, Goldenseal will
warn you if the total amount of purchases exceeds the purchase order
amount, or if purchase orders are required and none has been entered.

Investment— materials and supplies used when managing an investment.
Real Estate— materials used for real estate repairs, or supplies consumed

as a part of rental property management.
You can also use the Applies To field to identify :To assign a purchase to a specific job, use the Job Class popup menu to

enter the type of job account, then click in the Job field, and assign the cost
to a specific project or other job.

Capital Improvement— a purchase that adds to the asset basis value of
an investment, equipment or real estate account, rather than being
handled as an expense.

Cost Categories and Locations
Credit— a transaction that reduces the amount owed to the supplier. The

gross amount of a credit is negative.
You can allocate each expense transaction to cost categories (see Lesson
11) and cost locations (see Lesson 12). Doing that will help you to get
accurate job cost information, which can help you to run your business
more profitably.

Finance Charge— a payment for interest on overdue items.
Return— a transaction that reduces the amount owed to the supplier,

and reduces the inventory quantity of any items that it includes. The
gross amount of a return is a negative number.
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Special Order— a purchase that has not yet been received. One-Time Vendors
Prepaid Expense— a purchase that will be used over a future time period.

In financial reports, the pre-paid amount is considered as an asset.
If you use some vendors infrequently and don’t want to set up an account
for them, follow these steps:

Payment Methods
1. Create one or more Material accounts to handle one-time purchases. In

the account, turn on the Allow One-Time Names checkbox.
2. To make a purchase from an infrequent vendor, create a purchase

transaction, and enter the account from step 1 into the vendor field.
Each purchase needs to have a payment method. Choose a method from
the Payment Method popup menu.

3. Turn on the One-Time checkbox.

Billed Purchases 4. Type in the name of the vendor.

Saving a Purchase
Choose Vendor Invoice as a payment method if you are not paying for this
item now. Goldenseal will add the purchase to your Accounts Payable.

You save a purchase transaction when you close its window, hit the Enter
key, Quit, or move to another record in the same window. When you save a
transaction, Goldenseal also automatically ‘posts’ it.

NOTE: Lesson 36 shows you how to pay your unpaid bills.

Goldenseal automatically enters the vendor’s usual payment terms into the
Details field. If this purchase uses some other payment terms, change the
contents of the Details field. WARNING: If you switch to a different window before you save a

transaction, it is left ‘dangling’. Other parts of Goldenseal will not know
what you have entered there until you save it.

HINT: To see the usual payment terms for this vendor, choose Main
Account from the View menu, and look at the Payment Terms field in
the vendor account record.

Required Fields
Instant Purchases When you complete a transaction, Goldenseal checks for fields that cannot

be left blank. For example, every purchase must have a vendor, and you
can’t close the transaction until you enter one.

If you are paying for this purchase immediately, enter the type of payment
into the Payment Method field. Enter a specific account into the Details
field— for example, if you are paying by check, enter a checking account. HINT: If you start a transaction and are not ready to complete it now,

change the Status field to Planned or Void.When you complete the purchase, a matching payment transaction will be
created automatically for the selected bank account. If you are paying by
check, you’ll be asked which checkbook to use for the payment.

Transaction PostingHINT: When you enter an instant purchase, all of your bookkeeping is
completed instantly. The expense is marked as paid, your bank balance
is adjusted, and job cost and billing information is posted
automatically.

When you save a transaction, Goldenseal automatically posts it to job
costs and expense accounts. Posting takes only a fraction of a second.

If the payment method is Vendor Invoice, Goldenseal adds the purchase to
Accounts Payable. For other payment methods, Goldenseal creates a com-
pensating bank transaction as soon as you complete the purchase.Unpaid Purchases

Use the Status popup field to mark purchases that will not be paid. To
track a purchase for job costing, choose Job Cost Only. To enter a price
quote that will be used to update unit costs, choose Pricing Only. If a
purchase won’t happen now, choose Planned or Void.

NOTE: If there is a ‘dangling’ transaction in the bank account that will
pay for a purchase, you won’t be able to save the purchase. In that
case, open the bank transaction window, complete the bank transaction
and save it. You can then save the purchase also.
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Closed Transactions To return a purchased item for credit after it has been billed or paid, follow
these steps:Goldenseal closes a purchase transaction when it is paid. For a prepaid

transaction, that happens as soon as you complete the transaction. For a
billed purchase, it happens after the bill is paid (see Lesson 36).

1. Find the original purchase transaction.
2. Choose Duplicate Record from the Edit menu.
3. Enter Return into the Apply To popup menu.

Transaction Links
In Goldenseal, most transactions are ‘linked’ to other transactions and
accounts. Use the following menu commands to see linked items:

Choose Material Account from the View menu to see the supplier
account.

Choose Project Account from the View menu to see the job account.
Choose Payment Transaction from the View menu to see the bank trans-

action that pays for this transaction (if the transaction is has not yet
been paid, this command is not available).

To see an account in an active clairvoyant field, click on the field’s popup
button, and choose View This… from the bottom of the menu (the name of
the command is different for each class of account or transaction).

Closed purchases have Paid in the Status field and a Paid watermark. You
can still change some fields, but the account, status, amount and payment
method fields are locked so you can no longer change them.

To see any account or transaction that is listed in a disabled (gray)
clairvoyant field, double-click on the field.

WARNING: If you use one of the linking commands to view a
transaction that is not currently in the list of found records, Goldenseal
will add it to the found set. Usually that is not a problem, but if you
have been using a group of found records to make reports, you may
need to re-find the original items.

NOTE: If you need to change a closed transaction, find the payment
transaction (see page 245) and set its status to Void. After you’ve
made the change, restore the payment transaction to its original status.

Canceling a Purchase
Finishing UpTo cancel a purchase but still keep it on file, enter Void into the Status

popup menu. In this lesson you’ve learned how to enter a material purchase. You may
want to try entering a few sample material purchases, just so you can get
comfortable with the data entry process.

To permanently remove a purchase, choose Delete Record from the Edit
menu.

For example, you could enter purchases for the following items:NOTE: You cannot delete records that have been paid or time-and-
material billed, or that have other transactions that refer to them. • 25 pieces of red licorice stick

If you have started to change an existing purchase and want to go back to
the original version, choose Revert Record from the Edit menu.

• 2 packages of Hostess Sno-Cones (discard the white ones)
• 1 roll duct tape

Voilá. An chic edible hat with detachable ear flaps!
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Lesson Thirty-Four: Purchase
Breakdowns

HINT: You can also use the mouse to click in a different cell, or use
the right and left arrow keys to move through the table.

8. Press the Tab key so the Unit Cost field is selected, and enter the price
for one unit of this item.

Many Goldenseal transactions include breakdowns. Breakdowns are a list
of specific items in a transaction that Goldenseal displays in a
spreadsheet-like table. Purchase breakdowns allow you to include multiple
items that you have purchased from the same supplier.

9. Press the Tab key so the Quantity field is selected, and enter the
number of units that you are buying.
HINT: Goldenseal calculates the total price for the row as soon as
you enter a quantity and unit cost. It also recalculates the gross price,
sales tax amount and net price for the entire transaction.This lesson shows you how to use a breakdown table to include several

items in a single material purchase. 10. Press the Tab key so the Size field is selected, and type in the size unit
that is used for this item.HINT: There is more about breakdown tables in the Estimating manual,

pages 18-21.

Category Breakdowns
If a purchase includes items in more than one cost category and you don’t
need to use specific Cost Items, use a category breakdown to divide it.

To do so, follow these steps:

1. Choose Material Purchases from the Costs menu.
2. Click the New button.
3. Click the Breakdown popup field, and choose Category. The window

will change so it includes a breakdown table.
4. Enter basic information about the vendor and job into the regular

fields in the top half of the window.
NOTE: One purchase transaction can currently include costs for only
one job. If a purchase includes items for more than one job, you’ll
need to enter more than one purchase transaction.

5. Click in the Category column in the first row of the breakdown table,
and enter a cost category. Type the first few letters of a category, and
enter it the same as in any clairvoyant field (see Lesson 2). 11. You have now entered complete information for one breakdown row.

12. Press the Enter key to start another row.HINT: When you click in a table cell that is a clairvoyant field, a
small popup button appears. You can use it to see a list of the
possible values for the field.

HINT: You can also insert a new row anywhere in the table. Choose
Table from the Edit menu, and choose Insert Row from the submenu.

13. Repeat steps 5 through 12 until you have entered each item that will
be included in this purchase.

6. Hit the Tab key to move to the next field. If the current category
system includes subcategories, enter a subcategory. Otherwise you can
leave this column blank. 14. Click the More Info button to enter job cost and billing details.

7. Press the Tab key so the Item field is selected, and type in a brief de-
scription of the item.
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5. Click in the Category column of the breakdown table, and enter a
category. You can also enter an optional subcategory.
HINT: You don’t need to enter a category or subcategory, but using
them gives you a shorter list of cost items to look through.

6. Choose an item from the clairvoyant field in the Item column. It will
list only those cost items that belong to the entered category.
HINT: If you don’t know the category for an item, leave the Category
column blank. The list will then include all cost items. Type the first
few letters of the item name into the clairvoyant field, and
Goldenseal will quickly find the desired item.

7. After a cost item is entered, Goldenseal automatically fills in its cost
and unit size.
HINT: To see more details about the cost item, double-click on any
non-editable column in the table (Size, Unit Cost or Item Total).

In job cost reports, Goldenseal will divide the costs for this purchase among
the five categories shown in the breakdown.

Item Breakdowns
An item breakdown is similar to a category breakdown, but it uses specific
cost items. Cost items allow you to keep track of each item that you buy,
sell, or use in projects.

HINT: There is more about cost items in Lesson 13.

To enter a material purchase that includes specific cost items, follow these
steps:

1. Choose Material Purchases from the Costs menu.
2. Click the New button. 8. Enter the quantity that you are purchasing.
3. Click the Breakdown popup button, and choose Item. 9. Press the Enter key to add a new row to the breakdown table.
4. Enter basic information about the vendor and job into the fields in the

top half of the window.
10. Repeat steps 5 to 9 until you have entered all of the cost items that are

included in this purchase.
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HINT: To include an item that doesn’t have a cost item, enter
Unlisted Item into the Cost Area cell. You can also include sales tax,
delivery charges and assemblies (see Lesson 14).

Lesson Thirty-Five: More Expenses
This lesson shows you how to use Goldenseal to enter equipment hours,
inventory used, subcontractor costs and other costs.When you complete the transaction, Goldenseal uses the purchase prices to

update the estimated cost of any cost items. If the job is an inventory
account, Goldenseal also adjusts the inventory quantity of the cost items
that were purchased. In job cost reports, Goldenseal divides the costs for
this purchase among the categories shown in the breakdown.

Equipment Hours
Each time you use a piece of equipment, create an equipment hours record
to describe the work that was done.

Other Breakdowns To do so, follow these steps:

Category and item breakdowns are used in several other types of
transactions. You can include them in allowances, bank checks, bank
payments, bids, change orders, estimates, purchase orders and sales.

1. Choose Equipment Hours from the Costs menu.
2. Click the New button.
3. Enter the equipment account that was used for this work.

Some transactions show other types of breakdown. In many cases, these
breakdowns refer to other transactions, which are filled in automatically
when you change the breakdown type or the account.

Billing records for customers show unpaid sales.
Billing records for projects show draw schedule items, progress cate-

gories, or time and materials costs.
Payroll records show labor hours and payroll deductions.
Payment receipts and deposits show unpaid income transactions.
Bank checks and bank payments show unpaid purchases and payroll

records.
Bank deposits show undeposited income transactions.

Finishing Up
4. Enter the amount of time that the equipment was used, and choose a

time unit from the popup menu.This lesson has shown you how you can itemize purchases by category or
by cost item.

5. Enter the job type and job to which this transaction applies (see page
240). Also enter any special conditions that apply to this transaction
(see page 241).

You might want to take a break now to spend some time with friends,
travel to an exotic location, or buy something impulsive.

6. Click the More Info button to fill in billing and job costing details.Is there a ‘Gothic’ store in your neighborhood? If so, you might want to
check out their hat section. You might find a Gothic Carmen Miranda hat,
with gargoyles and bats hiding among black wax fruits. It’s stunning.

7. You can use the Breakdown popup to break the work down by
category or cost item (see Lesson 34).

When you complete the record, Goldenseal posts it to time and materials
billing and job costs, the same as a material purchase (see page 243).
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Inventory Used Subcontractor Cost Transactions
Create an Inventory Used transaction each time that you take materials
from inventory and use them on a project. To create an inventory used
record, follow these steps:

Create a subcontractor cost record each time that you receive a bill from a
subcontractor, or otherwise need to pay them. Subcontractor costs are very
similar to material purchases (see Lesson 33).

1. Choose Inventory Used from the Costs menu. To create a subcontractor cost record, follow these steps:
2. Click the New button. 1. Choose Subcontractor Costs from the Costs menu.

2. Click the New button.

3. Enter the Inventory account from which these items were taken.
4. Enter the item used, or use a breakdown to list multiple items (see

Lesson 34).
3. Enter the subcontractor who is being paid, and a brief description of

the work that was done.
5. Enter job cost details (see page 240). 4. Enter information about the billing amount (see the next section).

Goldenseal uses Inventory Used transactions for job costs and time and
materials billing, exactly the same as a material purchase (see page 238). It
also reduces the inventory quantities of any items listed in the Item
breakdown, and adjusts the value of the Inventory account.

5. Enter job cost information (see page 240).
6. Click the More Info button, and enter billing and job costing details.
7. Enter any special conditions that apply to this transaction (see page

241), and the method used to pay for it (see page 242).
For more about inventory, see Lesson 47. Subcontractor Billing Amount

Subcontractor cost records can handle simple bills (similar to a material
invoice) and time bills (where you pay a fixed amount per hour or day).

When a subcontractor bills for a fixed amount, follow these steps:

1. Choose Dollar Billing from the Time Used popup menu.
2. Enter the billing amount into the Gross Price field.
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When you pay a subcontractor by the hour or day, follow these steps: Other Cost Transactions
The data that you put into an other cost transaction is almost identical to
that in a material purchase (see Lesson 33). You identify the expense, and
assign it to a job, cost category and location. You can also apply the cost to
an allowance, bid, change order or other special conditions. Enter payment
methods the same as in the other types of expense transactions.

1. Choose Hour or another time unit from the Time Used popup menu.
2. Enter the amount of time included in this billing.
3. Enter the subcontractor’s billing rate into the Charge Rate field.
4. Goldenseal will calculate the Gross Price, based on the charge rate.

Billing Rates When you receive a bill for a miscellaneous cost, follow these steps:

1. Choose Other Costs from the Costs menu.A subcontractor cost record includes three different billing rates.
2. Click the New button.HINT: To view the billing rates, choose Billing Rates from the Options

menu, then choose Subcontractors from the submenu (see page 166).

The Subcontractor Charge rate is the amount the subcontractor is paid per
hour, day, week, or other time unit. This rate does not apply when the
subcontractor bills for a simple dollar amount.

The T&M Billing Rate applies only for time and materials projects. This
field determines that amount that is billed to the client when you create a
bill (see Lesson 43).

HINT: Goldenseal calculates the billing amount, and fills it into the
T&M Amount field. To reduce the chance of errors, you can’t change
this field. If you’d like to make it editable, use the Custom Layouts
command (see Lesson 21).

The Job Cost Rate determines the calculation method for job costs from this
transaction (see Lesson 39).

Printing 1099 Forms
If you turn on the Gets 1099 checkbox in your Subcontractor accounts, you
can print 1099 forms for your subs. To do so, follow these steps:

3. Enter information about the expense. The fields are almost identical
to those in a Material Purchase transaction (see Lesson 33).

4. When you complete an Other Cost transaction, Goldenseal posts it to
time and materials bills and job costs, the same as the other expense
transactions. Goldenseal also handles its payment exactly the same
as a material purchase (see page 242).

1. Enter all invoices from each sub, and wait until Jan 1 of the next year.
2. Choose Subcontractors from the Accounts menu.
3. Choose Find from the Edit menu.
4. Click on the Billing Setup button, and turn on the Gets 1099 checkbox.
5. Click OK.
6. Click the Find button. This will find all subcontractors that get 1099's.
7. Choose Print Forms from the File menu.
8. Enter Found Records into the Record Range field, and click OK.
9. Goldenseal will print forms with the previous year's 1099 totals.
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When to Enter Expenses Lesson Thirty-Six: Paying Bills
It’s a good idea to enter expenses as soon as you know about them. That
way your job cost information will be as up-to-date as possible. Goldenseal makes it easy to take your hard-earned money and pay it to

other people. This lesson shows you how to get money out of your check-
book and into the mailbox faster than you ever dreamed possible.

When you pay for an expense by cash, check or credit card, enter it as soon
as you can after the payment was made.

The Pay Bills Command
When an expense will be billed later, enter it as soon as you have a delivery
ticket or other indication of the amount owed.

Use the Pay Bills command to view your Accounts Payable. It shows a
‘quick report’ window that lists what you owe to each material, subcon-
tractor and other cost account. You can also use the Pay Bills command to
pay some or all of your bills right now.

Planned and Job Cost Only Status
You can pre-enter expenses before you know their exact cost. Use the best
guess at the cost, and give them either Planned or Job Cost Only status (use
the Status pop-up field in the left-center part of the window).

NOTE: In later lessons we’ll look at other ‘quick reports’ that handle job
costs, billing, payroll and deposits.

Transactions with Job Cost Only status will be included in job cost totals,
but won’t be used for time and materials billing or Accounts Payable.

To view your current Accounts Payable or to pay bills, follow these steps:

1. Choose Pay Bills from the Bank menu.
HINT: You can also use Job Cost Only status to enter past expenses, so
you’ll have accurate totals for projects that were underway when you
started with Goldenseal (see page 400).

Transactions with Planned status won’t be included in job costs, billing or
payables, but their total will appear in some reports that show planned
costs. When you actually purchase planned items, change the status from
Planned to Entered.

Finishing Up
This lesson has covered four more types of expense transactions. You can
use them to keep track of your equipment, subcontractor and miscellaneous
expenses, and get ready to pay bills that you owe.

Before you move on, you may want to take a break and think about more
expenses that you can add to your business, so you can enter transactions
for them.

2. You’ll see a list of material suppliers, with the amount that you owe to
each of them.
HINT: If there are more vendors than can fit in the window, click on
the down arrow to see the other vendors.

Wouldn’t you rather have several more copies of your accounting software?
How about our special autographed edition?

3. To choose which vendors to pay now, click in the Pay column.
Goldenseal only pays the rows that have a check mark next to them.Remember, with just a bit of duct tape, you can turn the extra copies of this

manual into chic silvery hats.
HINT: At the top of the window, you can see the number of bills, the
amount owed, and the amount being paid now.
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Viewing Invoices Changing the Items Shown
To view unpaid invoices for a vendor, double-click anywhere in their row.
You will see an itemized list of all unpaid transactions.

To change the items that are included in the list, click on the popup menu at
the upper right corner. You can include material suppliers, subcontractors
other cost accounts, or all three types of accounts. You can also include all
vendors with open invoices, or just the vendors that were previously found
with the Find command (see Lesson 16).

NOTE: If you previously made a payment ‘on account’ to this vendor, it
will also be included in the invoice breakdown (it is subtracted from the
current due balance).

You can also use the Pay Bills command to pay payroll taxes (see page
360) and sales taxes (see page 362).

Subcontractor Insurance
You can control how payments are made to subcontractors with insurance
that has expired. To do so, follow these steps:

1. Choose Subcontractors from the Accounts menu (see page 227).
2. Enter the insurance expiration dates for this account.
3. Enter the way you’d like to handle expired insurance for this account.

You can forbid payments, give a warning, take an automatic
deduction, or pay even if insurance is expired.

Put a check mark in the Pay column for each invoice that you want to pay
now. To pay just part of an invoice, enter the amount you want to pay into
the Pay Now column.

4. Repeat steps 2 and 3 for each subcontractor.

When you pay bills, Goldenseal will put an X in the Pay column for
subcontractors who should not be paid because of expired insurance. It
gives an alert for any subcontractors that have the ‘Ask first’ option.To adjust an invoice because of discounts or finance charges, enter the

amount into the Adjust column. Enter a negative number for a discount, or
a positive number for a finance charge.

Writing Checks
HINT: If you’ve set up vendor payment terms to include discounts or
finance charges, Goldenseal calculates the adjustment automatically. After you have decided which items to pay and have made any adjust-

ments, click Create Checks to pay for the selected items.
To return to the main Pay Bills window, click OK. You can also click Cancel
to return without saving changes.

Changing Cutoff Dates
The Cutoff Date field at upper right determines which items are considered
due or overdue. To see payables for a different date, follow these steps:

1. Click in the Cutoff Date field.
2. Type in a new date.
3. Hit the Tab or Enter key, or click in the table.
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Goldenseal will ask you which account to use for payment. If you choose a
checking account, you also can decide which checkbook to use.

Lesson Thirty-Seven: Bank Checks
In this lesson you will learn how to use the checking transaction window,
and how to enter bank checks.

Click OK, and Goldenseal will automatically create a bank payment for
every vendor that has a check mark in the Pay column.

NOTE: See Lesson 31 for bank accounts, Lesson 38 for bank payments
and transfers, and Lesson 44 for deposits.Printing and Saving Reports

Checking Transactions
To get a printed report for all items in the current window, click the Print
Report button. You will then see a dialog from your printer— set it up, then
click OK or Print. Checking transactions are very similar to the expense transactions shown in

earlier lessons. To see checking transactions, follow these steps:To get a text file that contains all the information in the current window,
click the Save As Text button. You’ll be asked where to save the text file.
Choose a location, give the file a name, then click Save. You can then switch
to a word processor or spreadsheet program to open the file.

1. Choose Checking Transactions from the Bank menu, then choose one
of the checking accounts from the submenu.

Expense Posting
After you pay for an expense, Goldenseal automatically changes the status
of the original transaction to Paid, and closes it.

HINT: See page 244 for more about closed transactions.
If you make a partial payment for an expense, the expense will have Part
Paid status, and the remaining balance will show up in the Pay Bills report.

If you overpay for a transaction, Goldenseal marks the transaction as paid,
and adds the excess to the ‘on account’ balance with that vendor. The next
time you pay bills, Goldenseal subtracts the ‘on account’ balance from the
amount you owe.

Finishing Up
In this lesson you have used the Pay Bills command to look at your
Accounts Payable and pay your bills. 2. You’ll see a transaction window that contains all transactions for one

checking account.
This might be a good time for a break. Have you cleaned out your hat closet
recently? You might consider donating some of your older hats to the local
Adopt-a-Hat program. Bank Transaction Menus

There are two ways to view bank transactions— one account at a time, or
all at once.Don’t forget that the leading cause of baldness is abrasive hats. You might

want to consider using aluminum foil to line the underside of your favorite
headgear. As a bonus, it will reflect thoughts back into your brain, and in-
crease your intelligence by up to 17% (and more).

To view transactions for just one checking account, click on the Checking
Transactions menu, then choose a checking account from the submenu.
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NOTE: You can only have one Checking Transaction window open at a
time. If you already have a window open for a different checking
account’s transactions, Goldenseal will close it before it opens the new
checking transaction window.

Use the following transaction types for money that goes into a bank
account.

Deposit— for money that you put into an account from sales or bill
payments. Covered in Lesson 44.

To view all checking transactions at once, click on the Checking
Transactions menu, then choose All Accounts from the bottom of the
submenu. You’ll see all checking transactions for all checking accounts.

Transfer In— for interest income, and money that you are moving in from
other bank accounts. Covered in Lesson 38.

Reconcile Field
Bank Account Field Use the Reconcile field to match your computer records against the bank

statement, to make sure your balance is correct. There is more about
reconciling on page 287.

The bank account field is at the top of the window, immediately to the right
of the browse controls.

When you are viewing transactions for just one bank account, the bank ac-
count is always the same, and you can’t change it. New transactions will
always use the same account. Running Totals

Each bank transaction shows a running total for the bank account— which
it calculates from the account starting balance, adjusted by the current
transaction and all previous transactions.

HINT: To see details about the bank account, choose Main Account
from the View menu, or double-click on the account name.

When you view all accounts in one window, you can enter any bank
account for new records. If the running total is positive, it means you have money in the account. If it

is negative, it means the bank is storing negative currency for you.
NOTE: Goldenseal does not allow you to change the bank account for
previous transactions. HINT: Negative currency is red, not green, and it has pictures of bad

former presidents instead of good ones.

Transaction Types
To see the current balance, scroll to the last Bank Transaction record, or
check the Current Balance field in the bank account. Of course your actual
bank balance may be different, since transactions usually don’t clear in the
same order as they are entered.

When you create a new bank transaction, choose the transaction type from
the Type popup menu at top center. When you change the transaction type,
the fields in the main window will also change.

Creating ChecksNOTE: Goldenseal only lets you change the transaction type for the
most recent transaction.

You will probably enter most checks automatically with the Pay Bills
command (see Lesson 36) or the Write Payroll command (see Lesson 46),
or by instant purchases from an expense transaction (see page 242).

You can enter any of five different transaction types. Use the following
transaction types for payments that go out of a bank account:

Check— for regular hand-written or printed checks (available only in
Checking, Loan and Escrow Accounts). Covered in this lesson. You can also enter checks one at a time— especially if you have already

written the paper check before entering it into Goldenseal. When you enter
checks directly into Goldenseal, you need to ‘account for’ the payment.
Usually you do that by referencing one or more expense transactions.

Payment— for withdrawals, debit and credit card purchases, automatic
fund transfers, and other forms of payment that don’t use a
sequential check number. Covered in Lesson 38.

The following sections explain how to enter checks for specific situations.Transfer Out— for bank service charges, and money that you are moving
to other bank accounts. Covered in Lesson 38.
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Paying For One Expense Transaction Paying For Several Expense Transactions
To write a check for one unpaid expense transaction, follow these steps: To write a check to pay for several unpaid expense transactions from the

same vendor, you'll usually use the Pay Bills command (see page 257).1. Choose Checkbook Transactions from the Bank menu, then choose a
bank account from the submenu. If you'd like to enter expense payments directly into a checking transaction,

follow these steps:2. Click the New button.
3. Enter the payee type, and the account being paid. 1. Choose Checkbook Transactions from the Bank menu, and choose a

checking account from the submenu.4. In the Transaction Paid field, choose the type of transaction that this
payment covers— for example, a material purchase. 2. Click the New button.

3. Enter Bank Check into the Type field near the top of the window.
4. Enter the payee type, and the account being paid.
5. Enter Purchase into the Breakdown popup menu.

5. The Reference field shows all unpaid transactions for the account you
have entered. Choose the item that you want to pay (you can type a
name into the Reference field, or click on the popup button to the right
of the field to see a list of all unpaid items).

6. Goldenseal shows a breakdown table that automatically includes all
unpaid transactions for the selected account.

7. Turn on the check mark in the Pay column for each item that you want
to pay now. You can also change the amount in the Payment column,
to pay for just part of a transaction.

6. Goldenseal automatically enters the correct amount to cover this
transaction. When you complete the bank check, it marks the original
expense transaction as paid. HINT: To see a transaction listed in the breakdown table, double-

click on any non-editable cell in the transaction’s row.HINT: To see the transaction that this payment covers, choose Detail
Transaction from the View menu.
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Direct Purchases Preferences from the Options menu, then choose Expenses from the
submenu. Turn off the Allow Direct Bank Purchases option.

You can make purchases directly from a bank transaction. Direct purchases
appear in job costs the same as regular expenses, although they can be more
difficult to find later (see the note at the bottom of this page).

HINT: When you enter expenses and pay by cash, check or credit card,
Goldenseal creates an ‘instant purchase’ bank transaction to handle the
payment (see page 242). It’s just as easy as a direct purchase.

To enter a direct purchase, follow these steps:

Paying On Account
1. Choose Checkbook Transactions from the Bank menu, and choose a

checking account from the submenu.
You can make a payment ‘on account’ without applying it to a specific
transaction. Goldenseal subtracts the ‘on account’ balance from the amount
owed for purchases, the next time you use the Pay Bills command.

2. Click the New button.
3. Enter Bank Check into the Type field near the top of the window.
4. Enter the payee type, and the account being paid.

HINT: It is not hard to identify specific bills when you make payments
(see pages 265 to 266), so the only time you need to pay on account is
when you make a payment before you enter the purchases.

5. Enter Category or Item into the Breakdown field.
NOTE: Don’t use a Purchase breakdown. That is for purchases that
were already entered as separate expense transactions.

To pay a vendor ‘on account’, follow these steps:6. Enter other details about the purchase.
1. Choose Checking Transactions from the Bank menu, then choose the

account that is the source of the cash.
2. Click the New button.
3. Enter Payment into the Type field near the top of the window.
4. Enter the payee type, and the account being paid.
5. Enter Paid On Account into the Transaction Paid field.

Should you Use Direct Bank Purchases?
Purchases entered directly into a bank transaction can be difficult to find
later, especially if you don’t remember how you paid for the item. So it’s
usually better to not use direct purchases.

6. Enter the payment amount into the Amount field.
To forbid direct payment of expenses from a bank account, choose
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Writing Checks to Other Bank Accounts 2. Choose Bank Checks as a Transaction.
3. Choose one of the check forms as a Form Type.To write a check that transfers funds to another of your bank accounts

(including Cash accounts), follow these steps: 4. Choose Unprinted Checks, or one of the other record ranges.
5. Click the Print button.1. Choose Checking Transactions from the Bank menu, then choose a

bank account from the submenu. NOTE: There is more about the Print Forms command in Lesson 19.

Viewing Transaction Links
2. Click the New button.
3. Enter the class of the receiving account into the Pay To field.
4. Enter the account into the Account field. When you are viewing a paid expense, choose Payment Transaction from

the View menu to see the bank transaction that made the payment.5. Enter other information about the check.
6. When you complete the transaction, Goldenseal automatically creates

a compensating Transfer In transaction in the receiving account. When you are viewing a bank check or bank payment that pays for one
expense, choose Details Transaction from the View menu to see the item
that was paid.HINT: To pay bank service charges, or to transfer funds in any way

other than by check, use a Transfer Out transaction (see Lesson 38).
When you are viewing a bank check or bank payment that includes a
breakdown of several transactions, double-click in any non-editable cell in
a transaction’s row to see that transaction.

When you transfer money between two bank accounts, the transaction is
considered as an internal transfer— it is neither an expense nor income.

NOTE: If you write checks to pay for bank service charges, you will
need to enter the bank as an Other Cost account. That is not necessary
if bank charges are debited directly from the account (see page 272). Bank Reports

Printing Checks
To see a list of all checking transactions, choose Banking from the Reports
menu, then choose Checking Transactions from the submenu. Other
commands in the Banking menu show you other bank transactions.To print checks onto pre-printed forms, follow these steps:

HINT: There is more about using reports in Lesson 20.1. Put any brand of pre-printed check forms into your printer.
The Checking Transaction Report is like a checkbook register-- it shows one
transaction per line, with just the most basic information.

HINT: If you are just starting out, it’s a good idea to print onto plain
paper first. Different printers have different margins, and you may
need to change the form layout to get it to look right (see Lesson 21). If you double-click on a checking transaction in the report, you’ll see more

details for that transaction.2. Choose Print Forms from the File menu.

Finishing Up
In this Lesson you have seen how to enter checks.

Now that you are experienced with Goldenseal’s check-writing features,
why don’t you have some fun writing sample checks to friends, technical
writers, and charitable organizations such as tech writer support groups?

Of course, if you don’t want to actually send the checks, you can always
use a stapler or duct tape to turn them into chic watermarked hats, just the
right size for the smaller pets in your life.
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Lesson Thirty-Eight: More
Bank Transactions

Bank Payments
Bank payments are very similar to bank checks— the only difference is that
they don’t have sequential check numbers.

Use bank payments for any of the following:This lesson shows how to handle bank payments, interest, bank service
charges, and transfers between bank accounts. • Electronic payments, wire transfers and ‘e-checks’

• Automatic transfersIt also explains how to reconcile your bank records, and how Goldenseal
‘posts’ financial information after you complete a bank transaction. • Credit card and debit card purchases

• ATM withdrawals

Other Bank Transactions • Cash payments

Goldenseal creates most bank payments automatically when you make an
‘instant purchase’ and pay by cash, credit card or checking debit (see
page 242). It also creates bank payments if you use the Pay Bills command
and pay by something other than a check.

The six other classes of bank transactions are very similar to checking
transactions. For each of them you will set up accounts, and then enter
bank transactions when you move money in and out of the accounts.

You can use any of the following bank transactions: To enter a payment from a cash account, follow these steps:
Cash— for petty cash, cash registers or cash drawers, cash stuffed into

mattresses, piggy banks, or any other cash in your possession. 1. Choose Cash Transactions from the Bank menu.
2. Click the New button.Checking— for checking accounts (using sequential checks).
3. Enter a Payee Type, and the account to whom you’re making the

payment.Investment— for CD’s, IRA’s, stocks, bonds, precious metals and other
investments. This is a catch-all class that you can use for any business
asset that doesn’t fit into one of the other asset classes. 4. Enter other details for the payment. You can make the same types of

payments as for checking transactions (see Lesson 37).Savings— for bank accounts that don’t use sequential checks.
Credit Cards— for credit cards that you pay via a monthly statement.

NOTE: You do not need a Credit Card account for debit cards
(where the money is withdrawn from your bank account). Instead,
enter a payment transaction for the bank account from which funds
are taken. You also don’t need Credit Card accounts for vendor
accounts, even if you have a plastic card. Just handle it through the
regular Accounts Payable (see Lessons 33 and 36).

Loans— for notes, lines of credit, installment loans, and any other debts.
Escrows— for bank accounts that you manage on behalf of others.

Escrow accounts do not show up on your balance sheet at all.

You access all bank transactions through menu commands in the Bank
menu, similar to the way you handle checking transactions.

EXAMPLES: To move money into or out of a Cash account, choose
Cash Transactions from the Bank menu. To move money into or out of a
Credit Card account, choose Credit Card Transactions from the Bank
menu.

Page 270 Lesson Thirty-Eight More Bank Transactions More Bank Transactions Lesson Thirty-Eight Page 271



Bank Service Charges Earned Interest
Use a Transfer Out to enter check printing charges, monthly account fees,
over-limit fees, charges for returned deposits, and any other charges or fees
that you pay directly to the bank.

Use a Transfer In to enter interest that you earn on any type of bank
account.

To enter interest earned from an Investment account, follow these steps:
To enter a service charge for a Checking account, follow these steps: 1. Choose Investment Transactions from the Bank menu, then choose the

account into which the interest is credited.1. Choose Checkbook Transactions from the Bank menu, then choose the
account to which the charge applies. 2. Click the New button.

2. Click the New button. 3. Enter Transfer In into the Type field at the top of the window.
3. Enter Transfer Out into the Type field at the top of the window. 4. Enter Interest Received in the Transfer To field.
4. Enter Other Charge in the Transfer To field. 5. Press the Tab key, and enter the amount of interest earned.
5. Press the Tab key, and enter the amount of the charge.

6. Enter job cost information into the Job Class, Job and Category fields.
You probably will assign the interest income to an Overhead account,
but you can also assign it to a specific customer, project or other job
account.

6. Press the Tab key again, and enter any comments about the transfer.
7. Enter the form of transfer into the Conditions field.
8. Enter job cost information into the Job Class, Job and Category fields.

You probably will assign the cost to an Overhead account, but you
can also assign it to a specific customer, project or other job account. Other Credits

Interest Charges
When you receive a miscellaneous non-interest credit directly from a bank
account, enter it exactly the same as earned interest, but enter Other Credit
into the Transfer From popup field.When you pay interest on a loan or credit card account, enter it exactly the

same as a service charge, but enter Interest Paid into the Transfer To popup
field.
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Transfers Between Accounts One-Time Payments
Use bank transfers to shift money from one bank account to another. For
example, to transfer funds from an investment account to a checking
account, follow these steps:

If you need to make a payment to someone and don’t want to set up an
account for them, follow these steps:

1. Set up a cost account for ‘one time’ payees, and turn on the Allow
One-Time Names checkbox (see page 243).1. Choose Checking Transactions from the Bank menu, then choose the

account into which funds will be deposited. 2. Enter a check or bank payment to that account.
2. Click the New button. 3. Turn on the One-Time checkbox, and type in a payee name.
3. Enter Transfer In into the Type field at the top of the window.

Tax Class Field4. Enter Investment Account in the Transfer From field.
5. Enter the account that is the source of funds into the Account field.

Every bank transaction includes a Tax Class field, which classifies your
cash income and expenses for income tax reporting (see page 354).6. Enter the amount of the transfer.

Goldenseal automatically enters a basic tax class for each transaction,
based on the transaction type and the main account class.

To assign a different tax class to an account, follow these steps:

1. Choose Material Suppliers from the Accounts menu.
2. Find the account you’d like to change.
3. Enter a cost category into the Income Tax Class field.
4. Goldenseal will automatically use the new tax category for all

payments to that supplier.

Bank Transaction Posting
Every bank transaction must be ‘accounted for’. You must apply it to an
expense or income transaction, apply it to multiple items with a break–
down, or use it as a payment ‘on account’ so it covers future transactions.

7. Press the Enter key to complete the transaction.
Goldenseal automatically ‘posts’ each bank transaction. It will either mark
another transaction as paid, or it will change the ‘on account’ balance in the
account that made or received the payment.

Follow the same steps to handle other transfers such as an ATM
withdrawal that you put into a Cash account, a transfer from savings to
checking, or an automatic bank payment to a loan account.

Bank Checks and Bank PaymentsNOTE: If you write a check to transfer funds, enter a Check transaction
instead of a transfer (see page 261).

If a bank check or bank payment has no breakdown, use the Payment Type
field to determine how to apply the payment.When you enter a Transfer In, Goldenseal automatically creates a Transfer

Out in the other bank account. To see the offsetting transaction, double-
click in the Transaction Ref field at lower right. • If you apply the payment to a specific expense transaction, Goldenseal

changes the status of that transaction to Paid.
NOTE: If you are viewing transactions for just one account and you’ve
made a transfer to another account of the same type, Goldenseal won’t
be able to display it.

• If you pay on account, Goldenseal adds a vendor credit that applies to
future transactions.
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If the transaction has a Category or Item breakdown, Goldenseal considers
it to be an expense transaction. Job cost reports will include the transaction,
the same as a regular material purchase (or other expense transaction).

Reconciling
The Reconcile command matches your records against the bank statement.

HINT: If an employee enters checks, then an owner or a different
employee should always do the reconcile (and investigate any suspicious
items). It’s a good way to catch fraud, or prevent it in the first place.

NOTE: Category and Item breakdowns are not available if the Allow
Direct Bank Purchases checkbox is turned off in the Expense
Preferences window (see pages 266-267).

Before you start reconciling, set up reconcile periods for each statement
period you’ll be reconciling. To do so, follow these steps:If the transaction uses a Purchase breakdown, Goldenseal applies the

payment to the listed purchases.
1. Choose Other Lists from the Options menu, then choose Reconcile

Periods from the submenu (see page 234).
Deposits 2. Click the New button.
If a deposit has no breakdown, use the Payment Type field to determine
how to apply the deposit.

3. Type in a name for the period (e.g. month and year), then click OK.
4. Repeat steps 2 and 3 for each statement period.

• If you apply the payment to a specific income transaction, Goldenseal
will change the status of that transaction to Paid. Marking Cleared Transactions

• If you enter it as a payment received on account, the customer gets a
credit that will apply to future transactions. Always start with the bank statement for the first month in which you

started using Goldenseal. Follow these steps to mark each cleared item:
HINT: To view the ‘on account’ balance for an account, open the
browser window for that account and check the calculated values at
the bottom right corner of the window.

1. Choose Checkbook Transactions from the Accounts menu, then choose
the checking account name from the submenu.

2. Browse through the bank records. If the statement shows that a
particular transaction has cleared, enter the current reconcile period
into the Reconcile field. Repeat for each transaction that has cleared.

If the deposit uses a Payment breakdown, Goldenseal applies the deposit
to the listed items.

NOTE: For more about Deposits, see Lesson 44.

Reconciling against the Statement
Transfers In and Out After you have marked cleared transactions in the Statement field, you can

reconcile your totals against the bank statement. Follow these steps:If you enter a Transfer In or a Transfer Out for another bank account,
Goldenseal considers the transaction to be a simple transfer between
accounts. The two account balances are changed, but no other posting is
done.

1. Choose Checking Transactions from the Bank menu, and choose an
account from the submenu.

2. Choose Reconcile from the Bank menu.
If a Transfer In is for Interest Received or Other Credit, you can assign the
income to any job account. Usually you will add it to an Overhead account,
but you can also assign it to another type of account. Goldenseal posts the
job costs, but doesn’t post to any accounts.

If a Transfer Out is for Interest Paid or Other Charge, you can assign the
cost to any job account. Usually you will add it to an Overhead account,
but you can also assign it to another type of account. Goldenseal posts the
job costs, but doesn’t post to any accounts.

3. Enter the reconcile period that you used for this period, then click OK.
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3. Click the Update button. You’ll see a simple list of all cash
transactions during the time period.

To see a breakdown of cash income that you can use for income taxes or
detailed income statements, follow these steps:

1. Choose Taxes from the Reports menu, and choose Income Tax Report
from the submenu.

2. Enter a date range.
3. Click the Update button. You’ll see a list of all cash transactions

during the time period, broken down by tax classes.

Accrual Accounting4. Check the computer balances against the bank statement.
Accrual accounting is based on when expenses and income are actually in
place— usually when goods or services are delivered or installed.

5. If the balance does not match the bank statement balance, check for
errors, and repeat the reconcile process until it matches.

You can get accrual information from your expense transactions—
equipment hours, labor hours, inventory used, material purchases,
subcontractor costs and other costs.

Reconciling Multiple Periods
If you need to reconcile several month’s worth of bank statements, you’ll
need to do them in proper sequence. Follow these steps: To see a report of accrued expenses, follow these steps:

1. Start with the oldest statement. 1. Choose Expenses from the Reports menu, and choose All Expenses
from the submenu.2. Go through the reconciling process described in the previous section. If

necessary, adjust the account’s starting balance so Goldenseal’s
reconcile balance is exactly the same as the bank statement balance.

2. Enter a date range.
3. Click the Update button. You’ll see a simple list of all accrued expense

transactions during the time period.3. Move to the next oldest statement.
4. Reconcile that statement so it matches exactly. Get accrued income figures from your Sales transactions and project Billing

Records.5. Repeat steps 3 and 4 until you have finished all bank statements.

Cash Accounting Finishing Up
Cash accounting is based on when money changes hands. You can get that
information from your bank transactions, since all cash income is deposited
to a bank account, and all cash expenses are paid out of a bank account.

In this lesson you’ve learned how to make bank transfers to handle interest,
service charges and transfers between accounts. You might want to take a
break now, and fix some dinner.

HINT: In this case, cash accounting covers income and expenses in
cash, checking, credit card, investment, loan and savings transactions. Remember, a crisp dollar bill is a welcome addition to any salad. It has

zero calories and it’s jam-packed with fiber.
To see all of your bank transactions in one place, follow these steps: HINT: Smart chefs ‘de-vein’ larger denominations by removing the

colored plastic strip from the left side of the bill. Use a freshly honed
filleting knife, and save the strips to make an attractive garnish.

1. Choose Banking from the Reports menu, and choose All Bank
Transactions from the submenu.

2. Enter a date range.
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Lesson Thirty-Nine: Job Costs Category Breakdowns
To see a detailed breakdown of costs by cost category, double-click
anywhere in the row of the job you’d like to see.The Job Cost command shows you a ‘quick report’ of costs and income for

each of your projects, customers, and other jobs.

Looking at job costs is a valuable way to manage your business. It shows
the profitability of each part of your business, and helps you to increase the
accuracy of your project cost estimates.

Viewing Job Costs
Goldenseal lets you see the current financial state of each job very quickly.
To see a summary of job costs, follow these steps:

1. Choose Job Costs from the Costs menu.

You’ll see a list of cost categories, along with the expense amounts posted
to each category.

NOTE: The breakdown will only show categories that have a contract
amount or an expense amount. If you’d like to include all cost categories
in the display, hold down the Shift key when you double-click on the
row.

To "drill down" to see further details for costs within a category, double-
click in its row. If the selected category has subcategories, you’ll see a list of
its subcategories, with a breakdown for each. If the selected category does
not have subcategories, you’ll see a breakdown of expense items.

HINT: To bypass the subcategory display, hold down the Shift key
when you double-click on the row. That way you’ll see a list of cost
items for the category.

2. You will see a listing of projects, with a simple cost analysis for each. When you are finished viewing the category breakdown, click the Close
button, and you will return to the list of jobs.The first five columns for each job show the five basic expense classes, with

the amount that has been posted to each project. The next column shows
the amount of overhead allocated to the job.

The final three columns show the total costs for each job (from expense
transactions), the original budget amount (from the project estimate), and
the amount of income received (from deposits and payment receipts).
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Item Breakdowns
To see a breakdown of specific cost items for a job, follow these steps:

1. Choose Job Costs from the Costs menu.
2. Click on the Details popup menu at the bottom of the window, and

choose Item Breakdown.
3. Double-click in the row of the job for which you’d like to see a list of

items.
HINT: If you double-click in the Job column, you’ll see a list of all
costs. If you double-click in the column for one of the expense
classes, you’ll only see items of that class. 4. You’ll see a list of locations for the job, with job costs for each.

Viewing Other Job Types
To see costs for other types of jobs, use the Job Types menu at the upper
right corner of the main Job Cost window.

You can view job costs for any of the following account classes:

Projects— Totals for active or completed projects.
Customers— Totals for job costs assigned directly to customers.
Equipment— Expenses used to maintain equipment, and income that re-

sults from equipment use.
Real Estate— Expenses used to maintain real properties, and income that

results from rentals.
Investments— Expenses used to maintain investments, and income that

results from the investment.
Overhead— Expenses assigned to Overhead accounts, and income that

results from overhead allocations.4. A list of specific cost items will be shown.
NOTE: Material and other cost amounts are the same as the amount
of the expense transaction. Equipment, labor and subcontractor costs
are based on the Job Cost Amount in the expense transaction. Progress Tracking

Location Breakdowns
You can use the Job Costs command to track project completion, and get a
prediction of the final project cost.

To see a breakdown of job costs by location, follow these steps: NOTE: The completion percentages are also used for progress payment
billing (see page 310).1. Choose Job Costs from the Costs menu.

To track progress by cost category, follow these steps:2. Click on the Details popup menu at the bottom of the window, and
choose Location Breakdown. 1. Choose Job Costs from the Costs menu.

3. Double-click in the row of the job for which you’d like to see the
breakdown.

2. Click on the Details popup menu at the bottom of the window, and
choose Progress by Category.
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3. Double-click in the row of the job for which you’d like to see the
breakdown.

4. You’ll see a list of locations and the costs to date for each.
5. Enter the Percentage done for each location.
6. The predicted cost for each line item is shown in the Predicted column

for that row. The Variance column shows you the difference between
the predicted cost and the original budget.

7. The predicted cost and net profit for the entire project is shown at the
top of the dialog window.

8. To save the changes you have made, click OK. Click Cancel to leave
the progress window without saving changes.

Job Cost Reports
You can view job costs in several other formats using Reports (see Lesson
20). For example, the Job Costs by Category report shows you 'estimated vs
actual' costs for each category. The Job Costs by Subcategory report shows
you 'estimate vs actual' costs for each main category and smaller
subcategories.

Finishing Up
In this lesson, you’ve learned how to view job cost breakdowns, and how to
enter job progress so you can see a prediction of the final project cost.

You might want to take a break now for a walk to check out some of your
local wildlife. Do you have sea otters nearby? Mallard ducks? Moose?
Raccoons? Giant cockroaches?

4. You’ll see a list of categories, and the costs to date for each.
5. Enter the percentage done for each category.
6. The predicted cost for each line item is shown in the Predicted column

for that row. The Variance columns show you the difference between
the predicted cost and the original budget— as both a dollar amount
and as a percentage.

Which animals would you like to see returning to your area someday?

Which animals do you think would look best wearing the chic hats that you
made in previous lessons? This might be a good time to clean out your hat
closet, and at the same time practice your wildlife-stalking skills.7. The predicted cost and net profit for the entire project is shown at the

top of the dialog window.
HINT: It’s hard to put a chic hat on a moose, and it’s even harder to
keep it there. You might want to consider adding Velcro strips on either
side, so it will stick to the antlers.

8. To save the changes you have made, click OK. Click Cancel to leave
the progress window without saving changes.

To track progress by location within a project, follow these steps:

1. Choose Job Costs from the Costs menu.
2. Click on the Details popup menu at the bottom of the window, and

choose Progress by Location.
3. Double-click in the row of the job for which you’d like to see the

breakdown.
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Lesson Forty: Sales Customer Accounts
Create a customer account for each person or business who buys from you.
For more about customer accounts, see Lesson 9.This lesson shows you how to prepare for sales, and how to enter sales

transactions. If you don’t know all of your customers by name, create one or more
customer accounts to handle ‘one time’ sales, and turn on the Allow One-
Time sales option in them (see page 291).When to Use Sales Transactions

Delivery Methods
Use sales transactions for any of the following:

• When you sell retail goods.
Delivery methods allow you to set up a delivery or shipping charges for
orders of different weight or dollar cost.

• When you sell wholesale goods.
• When you provide services to customers.

To enter delivery methods, choose Income Setup from the Income menu,
then choose Delivery Methods from the submenu (see page 236).

Do not use sales transactions for the following:

• If you will receive more than one payment for goods or services that
cost a relatively large amount. In that case, create a Project account
for the item and use a draw schedule or progress payment to handle
the payments (see Lesson 43). Discounts

If you give discounts to some customers, follow these steps:• When you will bill for time and materials. In that case, create a time
and materials project for the item (see page 312). 1. Choose Income Setup from the Income menu, then choose Customer

Discounts from the submenu.• When you sell an expensive item and you’d like to track job costs for it
separately, rather than lumping it in with other work done for the
same customer. In that case, create a project for the item.

2. You’ll see a list of customer discounts. To create a new discount, click
the New button.

Sales Setup
Before you start making sales, there’s some setup you can do that will make
them work better. The next six pages cover sales setup.

Cost Items and Assemblies
If you plan to track inventory or you want to have Goldenseal calculate
prices automatically for you, create Cost Items for each item that you pur-
chase and sell. For more about cost items, see Lesson 13.
If you charge for services, create Assemblies to calculate the cost of each
service item that you provide. Assemblies are also helpful if you do
construction work, if you sell items that require some preparation work, if
you manufacture or assemble items, if you sell individual items from case
lots, or if you give package deals. For more about Assemblies, see Lesson
14.
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3. Each customer discount shows a list of item discounts. Enter the dis-
count that you give to this type of customer for each item, then click
OK.

Payment Methods
The list of payment methods lets you identify forms of payment that you
receive. You will use payment methods when entering sales, payment
receipts and bank deposits.4. If you give different discounts for different items, choose Income Setup

from the Income menu, then choose Item Discounts from the submenu.
You can enter as many item and customer discounts as you need to
handle all the different discounts you offer.

To enter payment methods, follow these steps:

1. Choose Income Setup from the Income menu, then choose Payment
Methods from the submenu.5. Assign customer discounts in each customer account (see Lesson 9).

Assign item discounts in each cost item or assembly (see Lessons 13
and 14).

2. Click the New button.

Customer Payment Terms
Use customer payment terms to set up billing intervals, due dates, and
other details for billed customers.

To enter a set of payment terms, follow these steps:

1. Choose Payment Terms from the Options menu, then choose
Customers from the submenu.

2. Click the New button.

3. Enter a name for the payment method.
4. Enter the type of payment.
5. If you give a discount for this payment method, fill in the amount.
6. For foreign currency, fill in the currency values— what you give to the

customer, and what the bank gives to you.
7. For payment methods that have a transaction fee, fill in the amount

and the account that receives payment.
8. For billed payment methods, fill in the usual payment terms.

When you make a sale that uses a Billed payment method, Goldenseal will
add it to Accounts Receivable (see Lesson 42). Sales that use other
payment methods are considered as cash sales, which you’ll deposit with
the Deposit Funds command (see Lesson 44).

3. Enter information about the payment terms.
NOTE: See page 232 for more about customer payment terms.
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Sales Branches
Sales branches allow you to track sales separately for different locations.

To set up a sales branch, follow these steps:

1. Choose Income Setup from the Income menu, then choose Sales
Branches from the submenu.

2. Click the New button.

5. Enter the way the sales tax amount is rounded.

You will use job sales taxes in estimates, sales, and project billing.

Unknown and One-Time Customers
3. Enter information about the sales branch. If you make cash sales to customers that you don’t know, follow these

steps:When you enter sales, you can assign each transaction to a specific sales
branch. 1. Create a Customer account to handle anonymous customers.

Sales Tax
2. Create a Sale transaction (see page 292), and enter the account from

step 1 into the Sold To field.

If you make cash sales to customers that you do know but that aren’t
regular customers, follow these steps:

The Job Sales Tax command sets up the sales tax rates that you charge to
customers.

1. Create one or more Customer accounts to handle one-time customers.
In the account, turn on the Allow One-Time Names checkbox.

To create a sales tax, follow these steps:

1. Choose Income Setup from the Income menu, then choose Sales Tax
from the submenu. 2. Create a Sale transaction (see page 292), and enter the account from

step 1 into the Sold To field.
2. Click the New button.

3. Turn on the One-Time checkbox.
3. Enter the tax agency that collects the payment.

4. Type in the name of the customer.
4. Enter the tax jurisdictions that receive a portion of this sales tax, and

the percentage for each.
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Sales Transactions If you use an Item breakdown, you can use a bar code scanner to enter
items by their UPC code. Goldenseal will automatically fill in the item
price, warn you about low inventory, adjust inventory quantities, and
automatically create a Purchase Order for items that are out of stock.

To enter sales transactions, follow these steps:

1. Choose Sales from the Income menu.
2. Click the New button. HINT: See Lesson 47 for more about inventory tracking.
3. Enter the customer to whom the sale is made.

You can save time by setting up templates for your typical sales
transactions. That way you won't need to fill in all the details every time.
For more about templates, see Lesson 24.

4. If the sale is for one item, enter a brief description. Otherwise enter
Category or Items into the Breakdown popup (see the next section).

5. Fill in the delivery, price and sales tax fields.

Viewing Sales Links
Choose Customer Account from the View menu to see more about the
customer account.

Choose Payment Transaction from the View menu to see the record of
payment for a sale (a payment receipt or a deposit). Choose Deposit
Transaction to see the deposit transaction.

If a Sale transaction has an Item breakdown, you can double-click on any
non-editable cell to see the Cost Item or Assembly for that row.

Finishing Up
In this lesson you have learned how to enter sales transactions. You’ll now
be able to sell anything— chic hats, pet flamingos, your soul, your DNA.

Speaking of genetic codes, did you know that Goldenseal contains over 6
million lines of code in the C++ programming language? No wonder it took
us more than 5 years just to finish the first version.

6. Enter the payment method.
7. If the item will be billed, enter payment terms.
8. Click the More Info button to enter the sales branch, sales rep, delivery

instructions and other details.
About half of the code is for the basic human interface— what you see on
the screen, and the way things work in clairvoyant fields, tables and all the
other Goldenseal components. The other half of the code handles the data
objects and the many details of business accounting.

9. To print a sales receipt, choose Print Forms from the File menu.

Sale Breakdowns There’s no simple conversion factor between programming code and genetic
code, but even the fanciest computer program is still much less complex
than something as simple as a fruit fly.

You can itemize a sale with a list of multiple items. To do so, enter
Category or Items into the Breakdown popup field. A category breakdown
lets you type in the name of each item sold, while an item breakdown
shows specific Cost Items or Assemblies.

“Time flies like an arrow. Fruit flies like a banana.” -- Groucho Marx

HINT: Sales breakdowns are almost identical to the category and item
breakdowns in expense transactions (see Lesson 34).
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Lesson Forty-One: Rental
Management

Leases
When you sign a lease with a tenant, first create a Customer account for
them (unless you already have one). To do so, follow these steps:

1. Choose Customers from the Accounts menu.This lesson shows you how to handle rental properties. If you don’t own or
manage rental properties, you can skip this lesson. 2. Click the New button.

3. Fill in details for the tenant (see Lesson 9).NOTE: You can also use the rental management features for long-term
equipment leases. For short-term equipment rentals or for leases that
include sales tax, use Sales transactions instead (see Lesson 40).

4. Hit the Enter key to save the record.

Then create a Lease transaction. To do so, follow these steps.

Rental Units
1. Choose Leases from the Income menu.
2. Click the New button.

To enter info about your rental units, follow these steps:

1. Choose Real Estate from the Accounts menu.
2.  Double-click on an existing rental unit in the table, or click the Add

Rental Unit button to add a new unit.

3. Enter the tenant’s name, and the property they are renting.
NOTE: You can rent real estate or lease equipment.

4. Enter the rental unit, and a brief description of the lease.
5. Enter the rent amount.
6. .Enter the time period of the lease, and the payment terms.

HINT: Goldenseal warns you if this lease overlaps an existing lease.
7. Click the More Info button to enter details about the damage deposit

and last month’s rent, if this lease includes them. You can also enter a
sales rep, payment terms and other details.3. Enter details for the rental unit. You can enter the usual payment

terms, the type of unit, usual rent, and details about the unit. If the
unit is currently rented, Goldenseal also shows you details of the
current lease.

4. To save changes in the unit, click OK.
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Lease Tracking Rental Expenses
When you have signed a lease, change its status to Active. Enter maintenance expenses for rental properties the same as any other

expense (see Lessons 33 to 35). Enter Real Estate into the Job Class field,
and the rental property into the Job field.When the lease is over and all payments have been completed, change its

status to Completed.
The Job Costs command will show you expenses vs. income (see Lesson
39).If you cancel a lease, change its status to Void.

See the next chapter for details on rental billing.

Other Rental Management Tools
Rental Transactions You can use the following Goldenseal features to help manage rental

properties:Rental transactions are a record of rent that is due. You can also use rental
transactions for deposits, for damages or other charges, and for refunds or
reimbursements that you give to your tenants.

Appointments— keep track of appointments with tenants and
prospective tenants (see Lesson 10).

To enter a rental transaction, follow these steps: Contact Log— record phone calls and other contacts with tenants and
prospective tenants (see Lesson 10).1. Choose Rental Transactions from the Income menu.

Escrow Accounts— manage escrow accounts for damage deposits (see
page 219).

2. Click the New button.

Problem Log— track progress on repairs and other problems (see Lesson
10).

Project Accounts— for new construction and major repairs of rental
units (see Lesson 9).

Purchase & Work Orders— write purchase orders for supplies, and
work orders for repairs and improvements (see Lesson 6).

Finishing Up
In this lesson you have learned how to use Goldenseal to manage rental
properties.

You might want to take a break now and ponder how you would handle
some unusual rental situations. For example, if you owned the White
House, would you file eviction papers if the President’s rent were overdue?
Would his or her party affiliation make a difference? If you owned the
Golden Gate Bridge, what color would you paint it? If you owned the
Statue of Liberty, would you rent out the plaques for advertising?

3. Enter the tenant. Goldenseal automatically enters the property, rental
unit and usual rent amount.

4. Enter a brief description for this rent amount.
5. Enter the type of payment and the payment method. You can also

enter any comments you have about this item.
Speaking of the Statue of Liberty, isn’t that a darned chic hat that she’s
wearing? To create it required over 1500 person-hours of work by skilled
metal workers, plus 600 kilograms of copper plating and eighteen jumbo
rolls of monument-grade duct tape.

HINT: You can use the Billing command to automatically create
rental transactions for damage deposits, last-month rent and regular
rent (see Lesson 42).
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Lesson Forty-Two: Sales
and Rental Billing

2. You’ll see a list of customers, and the amount that is due from each.
3. Click in the first column to choose which customers to bill now.
4. To see detailed sales for a customer, double-click on their name (or

elsewhere in the same row).
This lesson explains how to use the Billing command to bill for customer
sales and property rentals.

Billing Setup
Before you start sales billing, follow these steps:

1. Create Customer accounts (see Lesson 9) and Customer Payment
Terms with your usual terms (see page 232).

2. Create Payment Methods for the payments you receive (see page 289).
3. Enter Sales transactions for the goods or services that you provide

(see Lesson 40).

Before you start rental billing, follow these steps:
5. You’ll see a list of sales that are due. Click on the check marks in the

first column to determine which sales to include in this bill.1. Create Rental Payment Terms with your usual terms (see page 294).
2. Create a Lease for each tenant (see page 295). Fill in the rent amount,

the rent period, and any damage deposits or pre-paid rent. 6. When you are finished looking at itemized sales, click the OK button.
7. To create bills, click the Create Bills button. Goldenseal will create

billing records for each customer (see page 304).3. Create Payment Methods for the payments you receive (see page 289).

Sales Billing Viewing Accounts Receivable
To create bills for customer sales, follow these steps: The Billing command is a quick way to see the status of your Accounts

Receivable.1. Choose Billing from the Bank menu, then choose Sales Billing from the
submenu.

To view the billing status for a different date, type a date into the Cutoff
Date field, and press the Tab key to recalculate billing amounts.

To see a more detailed report of receivables that are due and overdue,
choose Income from the Reports menu, and choose Receivables Aging from
the submenu.

To see a list of all unpaid billing records, choose Income from the Reports
menu, and choose Unpaid Bills from the submenu.
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Rental Billing 5. Click in the first column to change the items to bill now. Click in the
Adjust column to enter early payment discounts or late charges.To create rental bills or to accept rent payments, follow these steps:

6. When you are finished with the itemized rental dialog, click OK.
1. Choose Billing from the Bank menu, then choose Rental Billing from the

submenu. 7. To create bills, click the Create Bills button. Goldenseal will ask you
for a payment method. If you are creating bills for unpaid rent, enter
Billed. Otherwise enter the type of payment you have received.

8. Goldenseal will create Rental Transactions for the rent that is due (see
page 296). If you are billing for rent, it also creates a Billing Record
(see page 304).

Damage Deposits
To bill for damage deposits, key deposits and pre-paid rent, follow these
steps:

1. Choose Billing from the Bank menu, then choose Rentals from the
submenu.

2. Double-click on the tenant who has paid a deposit.
3. Put a check mark next to each item that they are paying now.2. You’ll see a list of tenants, and the amount that is currently due from

each. Click in the first column to determine which tenants to bill now. HINT: If you don’t see the correct deposits or pre-paid rent, you’ll
need to enter them into the Lease (see page 295).3. To see details for a tenant, double-click anywhere in their row.

4. You’ll see a list of all payments and credits over the entire rental term.
Items that have already been billed are marked with an x in the first
column. Items that are due now are checked.

4. Continue rental billing, the same as for basic rent.
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Using Pre-Paid Rent Rental Deposit Return
When tenants pre-pay rent at the beginning of a lease term, enter it the
same as damage deposits (see page 301).

To return deposits at the end of a lease term, follow these steps:

1. Choose Billing from the Bank menu, then choose Rentals from the
submenu.When tenants use the pre-paid rent at the end of the term, follow these

steps: 2. Double-click on the tenant who is using pre-paid rent.
3. Put a checkbox next to the deposit return item(s) at the end of the

lease. If there are damage charges, also include them.
1. Choose Billing from the Bank menu, then choose Rentals from the

submenu.
2. Double-click on the tenant who is using pre-paid rent.
3. You’ll see a rental amount for the usual rent. Put a check mark next to

it to include it.
4. You’ll see a line for Last Payment Used. Put a check mark next to it.

4. Continue rental billing, the same as for basic rent. When you are asked
for a payment method, choose Billed.

5. Goldenseal will create a Rental Transaction for each credit and charge,
and a Billing Record for the total refund (or charge).

To issue a deposit refund check, follow these steps:5. Continue rental billing, the same as for basic rent. If the two amounts
cancel out, you won’t need to bill anything. 1. Choose Checking Transactions from the Bank menu, then choose the

account from which you’ll make payment.

Damage Charges HINT: If you keep damages in an escrow account, choose Escrow
Transactions from the Bank menu.

If you charge a renter for damages, follow these steps: 2. Click the New button.
1. Choose Rental Transactions from the Income menu. 3. Enter Renter in the Pay To field, and enter the tenant into the Account

field.2. Click the New button.
3. Enter the renter, and any details about the damages. 4. Enter Billing Refund into the Transaction Paid popup field.
4. Enter Damage Charge into the Transaction Type popup field. 5. Enter the billing record into the Reference field.

Page 302 Lesson Forty-Two Sale and Rental Billing Sale and Rental Billing Lesson Forty-Two Page 303



Billing Records To find and print the sale transactions covered by a customer bill, follow
these steps:Billing records keep track of the bills that you send out to customers,

tenants, project owners, and anyone else who owes you money. 1. Choose Billing Records from the Bank menu.
2. Find the record that lists the sales you’d like to include.You’ll create most billing records with one of the Billing commands. When

you click the Create Bills button, Goldenseal automatically creates billing
records for each marked account.

3. Choose Detail Transactions from the View menu.
4. Goldenseal will open the Sales window and show the listed

transactions in the found set.To view billing records, follow these steps:
5. To print the invoices, choose Print Form from the File menu, choose

Billing Invoice in the Form Type field, and choose Found Records in
the Record Range field.

1. Choose Billing Records from the Bank menu.

Individual Billing
If you’d like to make a bill for just one customer or just one project, you can
create a billing record without using the Billing command. For example, to
create a bill for a single customer, follow these steps:

1. Click the New button.
2. Enter Customer into the Account Type popup menu.
3. Enter Sales into the Breakdown popup menu.
4. Goldenseal will automatically fill in a list of sales that are ready to be

billed for this customer.

Bill Tracking
Each billing record keeps track of an amount that is owed to you—

whether it comes from sales, rentals or project work.2. You’ll see a browser window that includes bills of all types.
3. Each record shows one billing cycle for one customer, tenant or

project. The total billing amount is calculated, including sales tax,
retainage and finance charges.

To view a list of unpaid bills, choose Income from the Reports menu, then
choose Unpaid Bills from the submenu.
When you receive payment for the bill, you’ll apply the payment to a
specific billing record (see Lesson 44). The billing record will then ‘pass
along’ the payment to any transactions that are included in the bill.

4. Most bills include a breakdown table, which is a list of unpaid
transactions or steps in a project. The table shows the same
information as in the Billing commands. You can change the items or
billing amounts in the table, just as you did in the Billing commands.

Finishing Up
Printing Bills In this lesson you’ve learned how to make customer and rental bills.

To print a billing statement for a customer, choose Print Form from the File
menu, then choose Billing Statement in the Form Type field. Before you move on, you may want to take a quick break to take your pet

for a walk. Or if it’s a fish or a gargoyle, teach it to speak.
NOTE: For more about form printing, see Lesson 19.
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Lesson Forty-Three Project Billing
Goldenseal includes specialized billing for projects This lesson covers the
following billing types:

Draw Schedules— For projects that use a fixed series of payments.
Progress Payments— For projects with payments based on the percentage

completion for different categories or locations.
Time and Materials— For projects with payments based on actual costs.
Allowances— For allowances used in a project estimate.
Change Orders— For changes made in a project.

For project billing, the Billing Record is the start of the billing process. It
usually contains a specialized breakdown which shows work completed
and ready to bill.

Project Account Setup
In the Project account, use the Billing Type popup field to determine how
you will handle billing for this project. Six types of billing are available:

Budget— For internal projects for which you will never create bills.
Draw Schedule— For billing that uses a fixed series of completion stages

(see below). When you use this billing type, enter a specific draw
schedule into the Draw Schedule field. 3. Enter a brief name for the terms, and any comments you have about it.

Time and Materials— For billing based on actual costs, plus an optional
management fee (set in the payment terms—see page 306).

4. If you’d like to print a longer description of payment terms onto bills,
enter it into the Form Message field.

Progress by Category— For billing based on percentage completion for
each cost category.

5. Enter the billing frequency, and the date that bills are due.
6. If you give a grace period before you start charging interest, enter it.

Progress by Location— For billing based on percentage completion for each
location in the project.

7. Enter any ‘hold back’ or retainage amount that is used for this type of
project billing. Retainage is not collected until the project has been
completed (see page 316).Progress by Item— For billing based on percentage completion for each

breakdown item in the project. 8. Enter any discounts you offer for early payments, and any charges
you add for late payments.

Project Payment Terms 9. Enter the management fee(s) that you use for time and materials
projects that use this set of payment terms.

Use project payment terms to set up basic billing options for projects. To
do so, follow these steps: 10. Enter a starting date into the Base Date field at upper right.

Goldenseal will automatically show you the billing dates for this year.
1. Choose Payment Terms from the Options menu, then choose Projects

from the submenu.
2. You’ll see a list of project payment terms. Click the New button.
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Draw Schedules Draw Schedule Billing
To create a schedule of project draw payments, follow these steps: Draw schedule bills use a fixed set of payments at different stages of

project completion. They apply to projects that have Draw Schedule as a
project type (see Lesson 9). They are the simplest project billing type.

1. Choose Income Setup from the Income menu, then choose Draw
Schedules from the submenu.

To create a draw schedule bill, follow these steps:2. You’ll see a list of draw schedules. Click the New button.

1. Choose Billing from the Bank menu, then choose Draw Schedules from
the submenu.

2. You’ll see a list of projects that use draw schedule billing, and the
amount that is due from each (see illustration on the top of the next
page). Click in the first column to choose which projects to bill now.

3. To see a detailed list of draw schedule steps, double-click anywhere in
a project’s row.

3. Enter payment information. You can charge a flat dollar amount as a
deposit or final payment. The remaining payments draws are each a
percentage of the remaining project amount.
NOTE: The table must add up to 100%. Goldenseal will complain at
you if it doesn’t.

4. When you are finished setting up the draw schedule, click OK.

To assign a draw schedule to a project, enter Draw Schedule into the Billing
Type popup menu, and enter the desired choice into the Draw Schedule
field.
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4. In the Phase column, you’ll see a list of draw schedule milestones. 2. You’ll see a ‘quick report’ list of projects that use progress payment
billing, and the amount that is due from each. Click in the first column
to determine which projects to bill.

HINT: To set up a list of draw schedule milestones, choose Income
Setup from the Income menu, then choose Draw Schedules from the
submenu (see page 308). 3. To set the amount to bill for a project, double-click anywhere in its

row.5. If a milestone is completed, click on the check mark in the first column.
If a milestone is partially completed, enter either the percentage of
completion, or the dollar amount that is ready for billing. Goldenseal
will add the amount to the Bill Now column.

4. You’ll see a list of cost categories, locations or cost items, and the
percentage of each step that has already been completed.
HINT: To set up the list of categories or locations in the project, open
the Project account and change the Category System or Location
Package field.

6. The Previous column shows items that were completed in a previous
billing.

7. When you are finished setting up the billing amount for a project, click
the OK button.

5. Click in the first column to bill for a category that has been partially or
completely finished.

8. Repeat steps 3 to 7 for each project that is ready to bill now. HINT: If you will only bill for part of the item, you can adjust either
the percentage completed or the amount due.9. To create bills, click the Create Bills button. Goldenseal will

automatically create billing records (see page 304).

Progress Payment Billing
Progress payment bills use the percentage of completion in each of the cost
categories, locations or cost items in a project.

To create a progress payment bill, follow these steps:

1. Choose Billing from the Bank menu, then choose Progress Payment
from the submenu.

6. When you are finished setting up the billing amount for a project, click
the OK button.

7. Repeat steps 3 to 6 for each project that is ready to bill now.
8. To create bills, click the Create Bills button. Goldenseal will

automatically create billing records (see page 304).
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Time and Materials Billing 5. You’ll see a list of expenses.
6. Click in the first column to change the billing status of any item.Time and materials bills use the actual cost of work to calculate billing

amounts. You can cover overhead and profit with a ‘management fee’, or
with markup and billing rates that are higher than actual costs.

7. When you are finished checking expenses for a project, click OK.
8. To create bills, click the Create Bills button. Goldenseal will

automatically create billing records (see page 304).To create time and materials bills, follow these steps:

Billing Rates1. Enter expenses for the project— use material purchases, equipment
hours, and other expense transactions (see Lessons 33 to 35).

Use billing rates to set the amount to bill for equipment, labor and
subcontractor hours that apply to a time-and-materials project. Billing
rates are also used to calculate job costs.

2. Choose Billing from the Bank menu, then choose Time and Materials
from the submenu.

To create billing rates for equipment, follow these steps:

1. Choose Billing Rates from the Options menu, then choose Equipment
from the submenu.

2. Click the New button to create a new billing rate.

3. You’ll see a ‘quick report’ list of projects that use time and materials
billing, and the amount that is due from each. Click in the first column
to determine which projects to bill now.

4. To see detailed costs for a project, double-click anywhere in its row.

3. Enter information about the rate.

To set the billing rate for an equipment account, follow these steps:

1. Choose Equipment from the Accounts menu.
2. Find the account you’d like to change.
3. Enter a billing into the Billing Rate field.

When you create an equipment hours, labor hours or subcontractor cost
record, Goldenseal automatically enters the usual billing rate for that
account. Enter a new rate into the T & M Billing Rate field if it is different
for this record.
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Allowance Billing Change Order Billing
Use allowance billing for items in a project estimate that are handled as an
allowance (see Lesson 6). The original allowance budget amount is already
included in the regular project billing amount, so allowance billing covers
the difference between the original estimate and actual costs.

Use change order billing for changes in a project. Each change order is a
‘mini-estimate’ for extra work (see Lesson 10). Change orders can be for a
simple fixed amount, or they can be calculated as time-and-materials.

To create bills for change orders, follow these steps:
NOTE: If costs are less than the original allowances, the billing amount
is negative. In that case it will be a credit against the main project cost. 1. Choose Billing from the Bank menu, then choose Change Orders from

the submenu. You’ll see a list of all active projects with change orders.
To create bills for allowances, follow these steps:

1. Choose Billing from the Bank menu, then choose Allowances from the
submenu. You’ll see a list of active projects that have allowances.

2. To bill for the change orders on a project, double-click on its row.

2. To bill for the allowances on a project, double-click on its row.

3. You’ll see a list of change orders for the project, along with details for
the costs to date. To bill for an item now, click in the far left row. To
see a list of costs for a change order, double-click in its row.

3. You’ll see a list of allowances for the project, along with details for the
costs to date. To bill for an item now, click in the far left row. To see a
list of specific costs for an allowance, double-click in its row. 4. When you are finished marking change orders, click OK.

5. To create bills, click the Create Bills button. Goldenseal will
automatically create billing records (see page 304).

4. When you are finished marking allowances for a project, click OK.
5. To create bills, click the Create Bills button. Goldenseal will

automatically create billing records (see page 304).
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Retainage Miscellaneous Charges
Goldenseal makes it easy to handle retainage— an amount that is ‘held
back’ until a project is completed.

Goldenseal automatically computes finance charges based on the unpaid
balance from the customer or project, and the charges included in the
payment terms that they use. Finance charges are shown in the Finance
Charges field.Charging Retainage
You can also type in a finance charge amount.To set up payment terms to include retainage, follow these steps:
To bill for finance charges manually, follow these steps:1. Choose Payment Terms from the Options menu, then choose Projects

from the submenu. 1. Choose Billing Records from the Bank menu.
2. Open an existing payment term, or click the New button. 2. Click the New button.
3. Enter the retainage amount into the Retainage fields (see page 306). 3. Enter the account type and account being billed.
4. Enter other information about the project payment terms. 4. Enter Finance Charge into the Billed Item popup menu.
5. Click OK. 5. Enter the amount of the charge into the Gross Amount field.

To charge retainage in a specific project, follow these steps:

Finishing Up1. Choose Job Accounts from the Accounts menu, then choose Projects
from the submenu.

In this lesson you have learned how to do billing for sales and projects.2. Find the project.
You might want to practice this lesson by creating some invoices to send to
people you know. Now is your chance to convert all the favors you have
done over the years into cold hard cash!

3. Enter the payment terms which contain retainage into the Payment
Terms field.

Deducting Retainage Don’t worry about what you put into the bills. Most people will pay them
without looking at the details, so long as you’ve developed a good-looking
logo (see Lesson 18).

When you create each Billing Record, the retainage amount is automatically
deducted. You can see the deduction on the Billing Record (see page 304).

HINT: If your logo is not attractive enough to inspire people to pay you
spontaneously, Billing Records can also be used for bribes, kickbacks,
extortion and blackmail.

Billing for Final Retainage Amount
When you are finished with a project, follow these steps to bill for the
retainage balance: ANOTHER HINT: In that case you might want to add ‘unmarked bills’

as a payment method. To do so, choose Income Setup from the Income
menu, then choose Payment Methods from the submenu.1. Do a final billing for the project. For a draw schedule or progress

payment project, make sure all items have been 100% billed. For a
time and materials project, make sure that all costs have been billed. STILL ANOTHER HINT: When record-keeping for illegal activities, it’s

a good idea to use euphemisms. For example, you can use ‘pansies’
instead of ‘hush money, ‘petunias’ instead of ‘bribes’, and ‘chrysanth-
emums’ instead of ‘assassinating business rival’. For a complete guide
to sleazy business euphemisms, see Appendix C.

2. Choose Billing Records from the Income menu.
3. Click the New button.
4. Enter Projects into the Account Type popup menu.
5. Enter the project into the Account field. YET ANOTHER HINT: If you are a florist, you may be falsely accused

of illegal activities because of the previous hint. For a list of acceptable
substitutes for common flower species, see Appendix D.

6. Enter Retainage Balance into the Billed Item popup menu. The current
balance of retainage is automatically entered into the Gross Price.
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Lesson Forty-Four: Making Deposits Allocating Payments
Use the Received For popup menu to allocate the payment.

This Lesson shows you how to handle incoming payments. If a payment covers a specific transaction, enter the type of transaction into
the Received For field, and enter the transaction into the Reference field.

Payment Receipts HINT: The menu only shows unpaid transactions for the payer.

Use payment receipts to make a record of money that you receive. If a payment does not cover a specific transaction, enter Gift or Paid On
Account into the Received For field.You do not need to use payment receipts— the deposit transaction usually

serves as sufficient record of payments received (see page 322).

Write-OffsCreate a payment receipt in any of the following cases:
If you decide to write off a sale or project billing, you can change its status
to Void, or follow these steps to get a specific record for the writeoff:

• When you want to print a receipt, and there is no other transaction
that you can use for that.

• When you receive a payment in more than one form (such as cash and
check combined). In that case, enter multiple payment receipts.

1. Choose Payment Receipts from the Bank menu.
2. Click the New button, and enter the transaction into the Received For

and Reference fields.• When you are receive payment in unusual form, such as foreign
currency, gift certificates, coupons, or a credit memo. 3. Enter a Payment Method that uses Write-off as a method (see page

289).• When you want a separate record of a payment for any other reason.

Creating a Payment Receipt Payment Breakdown
To enter an optional payment receipt, follow these steps: If a payment covers several transactions, follow these steps:

1. Choose Payment Receipts from the Bank menu. 1. Enter Payments into the Breakdown popup field (at the left side of
the window).

2. Click the New button.
3. Enter information about the payment.
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2. Goldenseal automatically enters a list of unpaid items for this
account. Put a check mark next to each item that is being paid now.

5. Put a check mark next to each item that you want to include in this
deposit. You can also adjust the deposit amount, if you have received
a partial payment.NOTE: If the payment is for less than the full amount of a trans-

action, enter a partial amount into the Payment Amount column. 6. When you are finished adjusting the deposit details, click OK.
7. Click Create Deposit to deposit all of the marked items.

Depositing Funds
To deposit funds into a bank account, follow these steps:

1. Choose Deposit Funds from the Bank menu. You’ll see a ‘quick report’
window that lists items that may be ready for deposit.

2. Click in the Type field and choose the type of items you’d like to
deposit. See the next section for more about the choices.

8. Enter the bank account into which the deposit will be made, then click
OK.

9. Goldenseal will automatically create deposit transactions, and mark
the source transactions as paid.

Types of Deposit Income
Goldenseal shows different items in the Deposits Funds window, based on
what you choose in the Type popup menu.

Payment Receipts— A list of all undeposited payment receipts.
3. You’ll see a list of income items, with the amount due, and the amount

that is ready to be deposited.
Cash Sales by Branch— A list of sales branches, with the amount of cash

sales received at each location.
4. Double-click on an item to see a detailed listing of the transactions

that are included.
Cash Sales by Date— A list of undeposited cash sales by date.
Billed Sales— A list of customers, with the outstanding balance for each.

NOTE: There are no further details for payment receipts or cash
sales by date.

Billed Projects— A list of projects, with the outstanding balance for each.
Rentals— A list of rental leases, with the outstanding balance for each.
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Bank Deposits Paying One Item
Bank deposits are very similar to other bank transactions (see Lessons 37
and 38). You’ll probably create most deposits with the Deposit Funds
command (see previous pages), but you can also enter them directly.

To deposit a payment from one sale or billing record, follow these steps:

1. Enter the type of transaction into the Payment Type field.
2. Enter the specific transaction being paid into the Transaction field.

Use deposits whenever you collect money from sales, billing or other
transactions, and want to put it into a bank account. If you keep money in
a cash account, you’ll also use deposits to add to the funds there.

HINT: To view the transaction or transactions that are being paid,
choose Detail Transaction from the View menu.

If the deposit does not reference a specific transaction, enter Received On
Account into the Payment Type field. Goldenseal will add the deposit
amount to the ‘on account’ balance for the payer.

Do not use deposits for money that you transfer from one bank account to
another— use a bank transfer instead (see page 274). Also use transfers for
interest and other miscellaneous income that comes directly from the bank.

Using Breakdowns
Creating a Deposit To deposit a payment for more than one transaction, follow these steps:

To create a checking account deposit, follow these steps: 1. Choose Checking Transactions from the Bank menu, and choose an
account from the submenu.1. Choose Checking Transactions from the Bank menu, then choose the

account that will be used. 2. Click the New button.
2. Click the New button. 3. Enter Payment into the Breakdown popup menu.
3. Enter Deposit into the Transaction field.

4. Goldenseal will automatically fill in a list of undeposited items from
this account. Put a check mark next to the items that are part of this
deposit. If partial payment has been received for some items, enter the
amount into the Payment Amount column.

4. Enter the type of account making the payment into the Kind field.
5. Enter the account making the payment into the Received From field.
6. Enter information about the deposit.
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Deposits On Account Lesson Forty-Five: Payroll Setup
If a customer pays you money that doesn’t apply to a prior transaction,
follow these steps: Goldenseal includes a full-featured payroll system that handles all types of

deductions, withholdings, insurance and taxes.1. Create a Deposit transaction.
Payroll integrates with the other parts of Goldenseal— the information that
you enter for payroll is also used to calculate job costs and time and
materials billing.

2. Enter the customer name and other details.
3. Choose On Account in the Transaction Paid popup field.

Deposit Posting Since payroll can be very complex, this manual will cover it in two separate
lessons. This lesson shows you how to set up your payroll, and the next
shows you how to run it on a weekly basis.When you receive payments or make deposits, Goldenseal automatically

‘posts’ the action to the transactions that are included in the deposit.

Payroll Overview
If you include sale, billing record or rental transactions in a payment receipt
transaction, Goldenseal changes their status to Paid. Paid transactions will
no longer appear as a part of Accounts Receivable. Before you begin to use payroll, you need to set up the following lists:

If you include sale, billing record or rental transactions in a deposit,
Goldenseal changes their status to Deposited.

Benefits— Create benefit items and benefit packages, and assign a benefit
package to each employee.

Labor Billing Rates— Create labor billing rates to calculate the cost of
labor for time and materials billing and job costs.

If a payment receipt or deposit covers only part of a transaction,
Goldenseal changes its status to Part Paid. The remaining balance will still
be included the next time you use the Deposit Funds command, or the next
time you create a payment receipt or deposit and reference the partially
paid transaction.

Payroll Taxes— Create or import tax items, tax tables and tax packages,
and assign a tax package to each employee.
HINT: Goldenseal already includes current tax tables for each state
and Canadian province. All you need to do is import them into your
company file (see page 396).

Finishing Up Vacations— Create vacation items and vacation packages, and assign a
vacation package to each employee.In this lesson you have learned how to make deposits.

Wage Schedules— Create standard wage schedules and sales commis-
sions, and assign them to each employee. You can also assign dif-
ferent wage rates to each employee.

You might want to take a break now, and wander down to the local branch
office of your local bank. Take a sniff. Doesn’t it smell good? That’s the
aroma of fresh currency.

You also need to set up two types of accounts:
In fact it smells so great, why make deposits at all? Just keep the stuff
around the office, and you won’t need to use room freshener. Or hang a bill
from the rear-view mirror in your car or truck, instead of a scented pine
tree.

Employee Accounts— Create an account for each employee (see page
222). You’ll assign each employee billing rates, a wage schedule, a
benefit package, a tax package and a vacation package. You will also
fill in the number of exemptions, and other tax withholding
information that applies to the taxes that you pay.Yes, you can also fold dollar bills into a chic green hat, suitable for

shopping or other festive occasions. It only takes about a half-dozen. You
might need to use some duct tape as a stiffener, if the bills are worn.

Other Cost Accounts— Create an account for each tax agency (see page
228).

HINT: For even more festive headwear, convert your currency into
foreign denominations that have brighter colors.

This lesson will cover each of these items.
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Benefit Items
Use benefit items for medical coverage, pensions, retirement contributions
and other employee benefits. Benefits can be employee deductions,
employer expenses, or payments made directly to employees.

To create a new benefit item, follow these steps:

1. Choose Payroll Setup from the Costs menu, then choose Benefit Items
from the submenu.

2. Click the New button.

3. You’ll see a list of all benefit items. Only those items that have a check
mark will be included in this package.

Assigning Benefits
To assign benefits to an employee, follow these steps:

1. Choose Employees from the Accounts menu.
2. Find the employee account.
3. Enter a benefit package into the Benefit Package field.

If an employee receives different benefits for different types of work, follow
these steps:

1. Create a wage schedule for each type of work (see page 335).
2. In each wage schedule, turn off the Use Employee Benefit Package

checkbox, and enter the benefits that apply to that type of work.
3. Enter information about the benefit.

Benefit Packages
3. When you enter labor hours, assign the appropriate wage schedule to

that work. The listed benefits will also be applied to that work.
Use benefit packages to assign specific benefits to each employee.

To see the items included in a benefit package, follow these steps:

1. Choose Payroll Setup from the Costs menu, then choose Benefit
Packages from the submenu.

2. Click on a package, then click the Edit button.
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Commission Rates Labor Billing Rates
If you pay a sales commission to employees, enter one or more
commissions— they are similar to wage schedules.

Use labor billing rates to calculate the amount you charge for time and
material billing of labor, or labor job costs.

To enter a commission, follow these steps: To create a labor billing rate, follow these steps:

1. Choose Payroll Setup from the Costs menu, then choose Commissions
from the submenu.

1. Choose Billing Rates from the Options menu, then choose Labor from
the submenu.

2. Click the New button. 2. You’ll see a list of billing rates. Click the New button.

3. Enter information about the billing rate.

Billing Calculations
When you set up labor billing rates, you can use several different
calculation methods:

3. Enter information about the commission.

Using Commissions Flat Rate— A fixed dollar rate is used.
Variable Rate— A different dollar rate is used for each employee.

To assign a commission to an employee, enter it into the Commission field
in the employee account record.

Pay Rate— The employee’s basic pay rate is used.
Pay Rate Plus Percentage— The employee’s basic pay rate is used, plus an

additional ‘burden’ percentage to cover employer taxes.To assign a commission for sales in a sales branch, follow these steps:
Net Cost— The employee’s total payroll cost is used, including employer

taxes, insurance, and benefits (see page 199).
1. Choose Income Setup from the Income menu, then choose Sales

Branches from the submenu.
Net Cost Plus Percentage— The employee’s total payroll cost is used,

including employer taxes and insurance, plus a percentage to cover
employer costs not included in tax items or benefit items.

2. Click on a sales branch, and click the Edit button.
3. Enter the commission rate into the Commission field.
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Tax Items Tax Tables
Create a tax item for each item that you withhold from employee payroll,
and for each employer tax or insurance that is based on payroll.

Tax tables compute federal, state and provincial tax withholding. They
usually use a ‘step table’ with different rates for different wage amounts.
Tax tables are always based on the formula method for computing taxes
(not the multiple-page ‘lookup tables’ used for manual computation).

HINT: Goldenseal already includes the correct setup for US and
Canadian federal taxes, and taxes for all states and provinces (see
page 161). You’ll only need to modify tax items or tax tables if the
withholding rate changes, or if you want to add additional withholding
for items such as union dues.

HINT: You’ll probably never need to create a new tax table.

To update a tax table from a state tax booklet, follow these steps:

1. Choose Payroll Setup from the Costs menu, then choose Tax Tables
from the submenu.To create a tax item, follow these steps:

1. Choose Payroll Setup from the Costs menu, then choose Tax Items
from the submenu.

2. Click on the tax that has changed, then click the Edit button.

2. Click the New button.

3. Enter information about the new tax item. You can set up the
calculation method for the item, and who receives payment for it.
HINT: Check the Reference manual for more about Tax Items. 3. Check the tax booklet. If the amount of an exemption has changed,

change the numbers on the left side of the window.
Tax Cutoffs 4. Check the withholding ‘step table’ in the booklet. If the cutoff

amounts, base amounts or percentages have changed, enter new
values into the table on the right side of the window.

Goldenseal automatically computes year to date figures for each deduction,
and stops deducting those items that cut off at a certain amount.
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Tax Packages Category Taxes
Use tax packages to assign specific taxes to each employee. Some taxes and insurance rates use different rates for the same employee

when they do different types of work. For example, in some states the
worker’s compensation rate is more expensive when an employee does
work that is considered more dangerous.

Some states require multiple tax packages as a way to assign taxes for each
marital status.

You may also need to use more than one tax package if different employees
have different withholding items— for example, if only some employees
pay union dues, if some get EIC payments, or if you have employees that
live in different states.

To set the rates for each type of work, follow these steps:

1. Choose Category Setup from the Costs menu, then choose Category
Systems from the submenu.

2. Click on the name of a category system, then click the Edit button.To see the tax items that are included in a tax package, follow these steps:

1. Choose Payroll Setup from the Costs menu, then choose Tax Packages
from the submenu.

2. Click on a package, then click the Edit button.

3. You’ll see a list of all tax items. Only those items that have a check
mark will be included in this package.

3. In the list of categories, type the rate for each category into the Comp
Rate or Tax Rate column.

4. To add a tax item to this package, click on it until there is a check
mark to its left. To remove an item from this package, click on it until
it has no check mark to its left.

NOTE: You may need to adjust your category system so it matches
the tax rate classifications for your state or your insurance company.

4. If you also use subcategories, click in each category, and enter rates
into each of its subcategories.

Page 332 Lesson Forty-Five Payroll Setup Payroll Setup Lesson Forty-Five Page 333



Vacations Wage Schedules
Use vacation items for vacations and holidays. To create a new vacation
item, follow these steps:

Wage schedules are used to set the pay period, payday, and other basic
payment information.

1. Choose Payroll Setup from the Costs menu, then choose Vacation
Items from the submenu.

HINT: If you use the same pay period for all employees, you can use
just one wage schedule (even if they each have a different wage rate).

2. Click the New button. To create a new wage schedule, follow these steps:

1. Choose Payroll Setup from the Costs menu, then choose Wage
Schedules from the submenu.

2. Click the New button.

3. Enter information about the vacation or holiday.

Use Vacation Packages to assign specific vacations and holidays to each
employee. To see the items in a vacation package, follow these steps:

3. Enter information about the new wage schedule.1. Choose Payroll Setup from the Costs menu, then choose Vacation
Packages from the submenu. HINT: If you use different pay periods, you may want the name to

describe the pay period— for example, ‘monthly salary’ or ‘hourly
paid weekly’.

2. Click on a package, then click the Edit button.
3. You’ll see a list of all vacation items. Only those items that have a

check mark will be included in this package.
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Pay Period and Paydays Wage-Based Benefits and Taxes
Choose the interval to use for pay periods— you can select weekly,
biweekly, monthly, or some other payment interval.

If each employee receives the same benefits and pays the same taxes for all
the work they do, turn on the checkboxes for Use Employee Benefit
Package and Use Employee Tax Package. In that case, Goldenseal will use
the information that you entered into the employee account.Also choose the way to calculate paydays. Payday can be on a fixed

weekday (either one week or two weeks after the close of the pay period),
or it can be a fixed number of days before or after the close of the pay
period.

If employees receive different benefits or pay different taxes for different
types of work, turn off those checkboxes, and enter a benefit package or tax
package into each wage schedule. That way you can control the rates that
are used for each item of work, when you enter labor hours.Enter a Base Period date— the start date for any pay period.

Goldenseal will then calculate all pay periods and paydays for the current
year, and display them in the table at right.

Assigning Wage Schedules to Employees

Wage Rate Amounts
To assign a wage schedule to an employee, follow these steps:

1. Choose Cost Accounts from the Accounts menu, then choose
Employees from the submenu.Goldenseal gives you two ways to handle the wage rate amount in each

wage schedule— you can use a variable rate (different for each employee),
or a fixed rate (the same for everyone). 2. Find the employee record.

3. Enter the wage schedule into the Wage Schedule field.
To use a variable rate, turn on the Use Variable Rate checkbox. Each
employee will receive a different wage rate. Enter the wage rate amount into
the Wage Amount field in the Employee account.

4. If the Wage Schedule uses a variable rate, enter this employee’s rate
into the Wage Amount field.
HINT: You can assign only one variable rate to each employee. If you
pay more than one wage rate to an employee, you will need to create
more than one Wage Schedule for them, and turn off the Variable
Wage Rate option for all but one of them.

HINT: Turn the checkbox on if you pay employees with the same pay
periods and overtime rates, but use different wage rates.

To use a fixed rate, turn the checkbox off, and enter the wage rate amount
into the Rate field. Goldenseal will pay all employees that use this wage
schedule at exactly the same rate. Other Cost Accounts

HINT: Turn the checkbox off if you have standard wage schedules that
are the same for all employees.

Create other cost accounts for each tax or insurance agency that collects
taxes or withholding. If you pay more than one tax to the same agency, you
only need one account. For more about other cost accounts, see page 228.

Owners and Salaried Employees
Finishing UpIf the company owner is paid via regular draw checks, create a Wage

Schedule for the owner, and enter the wage type that best describes the
payments. Use Owner Hourly for payments per hour worked, Owner
Salary for regular amounts, and Owner Draw for irregular amounts.

In this lesson you have learned how to set up for payroll. It’s complicated!

Maybe you’d be better off to just fire all your employees. Nobody would
steal your pencils then, and you could take a nap or eat chocolate any time
of day without being disturbed.If some employees are paid a regular amount each period no matter how

many hours they work, create a Wage Schedule for them and enter Salary
as the wage type. Speaking of chocolate, our manual-writing staff is definitely addicted.

Have you ever thought about sending them some?

Page 336 Lesson Forty-Five Payroll Setup Payroll Setup Lesson Forty-Five Page 337



Lesson Forty-Six: Writing Payroll 6. Enter a brief description of the work done by the employee. You can
also enter a more detailed description if you want.

7. Goldenseal automatically enters the employee’s usual wage schedule.
You can change it if you’ll use a different wage schedule for this work.

After you have set up for payroll, you’ll enter employee hours and then
write payroll each pay period. Goldenseal does all the calculations, so all
you need to do is data entry and a bit of double-checking for special
situations.

HINT: If you use more than one wage schedule for an employee, enter
a different Labor Hours record for the work done at each wage.

8. Enter the way you want to compute overtime for this work.HINT: As a bonus, Goldenseal uses the same labor information to
compute job costs and time and materials billing. 9. Enter the project where work was done.

HINT: If the employee works on more than one project during a pay
period, enter a different record for each project.

Labor Hours
10. Click the More Info button, and enter any additional billing and job

costing info that applies to this work.Before you do payroll, enter labor hours records for the work done by each
of your employees. Labor hours records are similar to the other expense
transactions covered in Lessons 33 to 35.

11. Repeat steps 2 to 10 for any additional work done by the employee.

Applies ToTo enter hours, follow these steps:

1. Choose Labor Hours from the Costs menu. Use the Applies To field to assign labor to an allowance or change order, so
this work will be included in the billing amount for them. You can also
assign labor to a bid or work order.

2. Click the New button.
3. Enter the employee doing the work.

You can also use the Hours Reduction option to subtract these hours from
the employee’s pay. Use it if you entered too many hours in a previous
labor hours record that has been closed and can’t be changed.

HINT: To correct a labor hours record that has not been closed, simply
enter a different amount in the Time Spent field.

Labor Breakdowns
Use breakdowns to enter more than one piece of work into a labor hours
record.

To assign job costs to specific cost items, choose Item in the Breakdown
field (for more about breakdowns, see Lesson 34).

To assign work to more than one cost category without using cost items,
choose Category in the Breakdown field.

4. Enter the amount of time that the employee spent on this work.
5. Enter the number of days that are covered by this record.

NOTE: Goldenseal uses the time spent and days worked values to
calculate overtime.
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Multiple Wage Rates Comp Time
If you pay an employee more than one wage rate during a pay period,
follow these steps:

If the employee is doing work that will not be paid now, choose Add To
Comp Time in the Details field. The hours will be job costed, and added to
the employee’s comp time balance instead of being paid now.1. Create a labor hours record for the first wage rate.
If prior comp time is being paid now, choose Use Comp Time in the Details
field. The work will be paid now, but not job costed.

2. Enter the desired wage schedule into the Wage Schedule field.
3. Enter the hours worked at that rate.
4. Enter job cost information for the work.

Paid Holidays and Vacations5. Repeat steps 1 to 4 for the work done at each additional rate.

Salaried Employees and Owners
When employees use paid holiday or vacation time, enter the hours as
usual, and enter Paid Holiday or Paid Vacation into the Overtime field.
You can assign the holiday cost to an overhead account, or to a specific job.Enter hours for salaried employees, partners, unpaid workers and owners,

just as you do for hourly employees. It will increase the accuracy of your
job costs if you keep track of their time and assign it to jobs.

If you forget to pay employees for a paid holiday, Goldenseal will remind
you about it when you write payroll for that pay period.

When you run payroll, Goldenseal will adjust the wage rate so salaried
employees get their usual salary amount.

Goldenseal automatically accrues vacation time in each pay period.

Time and Materials Billing and Job CostsFor employees or owners that get an irregular draw, you can type in
whatever the draw amount is for that period. You can also write a check
directly to owners, if their draw is not handled as a part of payroll. The way Goldenseal calculates labor costs for time and materials billing

and job costs depends on the calculation method in the labor billing rates
that you assign to each employee account and labor hours record (see page
329).Overtime

Use the Details field to set overtime conditions (and a few other things). If the billing rate uses a fixed rate or the Pay Rate option, the total cost of
labor is calculated as soon as you enter a labor hours record.At the Standard rate, Goldenseal automatically applies the overtime rate to

the excess when there are more than eight hours per day or more than 40
hours in a weekly pay period.

If the billing rate uses the Net Cost option, the actual cost of labor is not
calculated until after payroll is completed (see the next pages). After you
write payroll, Goldenseal automatically adds ‘burden’ to the billing
amounts. Burden includes the cost of taxes, insurance and benefits that are
paid by the employer.

NOTE: If you use overtime cutoff amounts that are different from 8
hours per day or 40 hours per week, change the cutoff amounts in each
wage schedule (see page 335).

NOTE: Before you write payroll, Goldenseal temporarily uses the Pay
Rate calculation amount for billing and job costs.

If you do not want overtime to be assigned to a labor hours record, choose
No Overtime in the Details field. To pay all the hours at the standard
overtime rate, choose Overtime Rate. To pay all the hours in a record at the
Saturday or Sunday overtime rate, choose Saturday Rate or Sunday Rate in
the Details field.

If you need to do time and materials billing before you write payroll, don’t
use the Pay Rate calculation option in the labor billing rate. Instead, use a
flat rate, or use the Pay Rate plus Percent option and add a percentage to
cover approximate employer burden (and overhead costs, if desired).NOTES:  To set the overtime rates, choose Payroll Setup from the Costs

menu, and choose Wage Rates from the submenu. You can also adjust
overtime hours when you write payroll (see the next section).

HINT: The Net Cost option is more accurate, since it uses actual
payroll costs.
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Writing Payroll 2. You’ll see a list of work done during the pay period, based on the
Labor Hours records for this employee.Once you have entered employee hours, follow these steps to write payroll:

3. You can adjust the overtime hours if they are not correct. You can also
decide not to include some hours in this pay period— simply turn off
the check mark in the far left column.

1. Choose Write Payroll from the Bank menu.

4. When you have finished adjusting hours, click OK.

Viewing Deductions
To see a list of tax deductions, double-click in the Deduction column in the
employee’s row.

2. You’ll see a ‘quick report’ list of employees, hours and payroll
deduction amounts.

3. Double-check to make sure all values are correct.

Viewing Hours Worked
To see an itemized list of the hours that an employee has worked, follow
these steps:

You can also see category taxes, benefits, employer taxes or accrued va-
cation for this pay period. Simply double-click in the appropriate column.

1. Double-click in the employee’s row on the Hours column.

Changing Pay Periods
Goldenseal starts out with the earliest pay period that contains unpaid
labor hours. Use the Pay Period popup menu to change to a different pay
period.

You can enter the current pay period, any of the three previous periods, or
the next pay period. You can also view all labor hours, or you can enter a
custom date range.

After you change to a different pay period, Goldenseal automatically
adjusts the Start Date and End Date fields and fills in the appropriate
labor hours.
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Using Multiple Wage Rates Payroll Records
Goldenseal starts by including all employee hours in the payroll report,
even if you used more than one wage schedule.

Goldenseal keeps details of each payroll payment in a Payroll Record. The
record contains several breakdowns that show the hours paid, employee
withholding amounts, employer taxes and benefits.NOTE: If you use more than one pay interval (for example, weekly and

biweekly), you’ll only see labor for one payroll interval at a time. To view payroll records that have already been created with the Write
Payroll command, follow these steps:To see the work done under just one wage schedule, enter a wage schedule

into the Wage Schedule field. 1. Choose Payroll Records from the Costs menu.
2. Scroll to the record you’d like to see.The Wage Schedule field is useful if you have a mixture of salaried and

hourly employees, or if you write separate paychecks for different types of
work. To write payroll for just one wage schedule, follow these steps:

HINT: If you have already created a paycheck for this record, you
won’t be able to change any items on it. However, you’ll still be able
to view the breakdowns for hours or deductions.1. Choose Write Payroll from the Costs menu.

3. Enter Wages in the Breakdown field to see the employee’s hours.2. Enter the wage schedule into the Wage Schedule field.
4. Enter Deductions in the Breakdown field to see employee deductions.3. Click the Write Payroll button.

4. Repeat steps 1 to 3 for each additional wage schedule. You can also
leave the Wage Schedule field blank to include all remaining work.

Creating Paychecks
When you are ready to create paychecks for this period, follow these steps:

1. Click the Write Payroll button.

5. Enter Employer Taxes in the Breakdown field to see employer taxes.
6. Enter Benefits in the Breakdown field to see benefit deductions.2. Choose the bank account from which you’ll write paychecks. If you

use multiple checkbooks, enter the checkbook that you want to use. 7. Enter Vacations in the Breakdown field to see vacation and sick time
used and accrued.3. Click OK, and Goldenseal will automatically create a payroll record

and a paycheck for each employee. 8. Click the Period Totals button to see total wages, commissions,
deductions and employer taxes.HINT: If you don’t want to create paychecks right away, leave the

Account field empty. You’ll still get payroll records for the period.
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Direct Entry of Payroll Records 3. Enter an employee into the Employee field.
4. Enter the type of adjustment that you are making.To create a payroll record that calculates wages and deductions for a single

employee, follow these steps: 5. If the adjustment applies to a specific tax item, benefit item or
vacation item, enter it into the Applies To field.1. Choose Payroll Records from the Costs menu.

Printing Paychecks and Paycheck Stubs
2. Click the New button.
3. Enter an employee into the Employee field.

After you create paychecks, you can print them onto check blanks, with a
detailed breakdown of wages, benefits and withholding.

4. Choose Wages from the Breakdown popup menu.
5. Goldenseal automatically fills in all available hours for this employee.

To do so, follow these steps:HINT: You may need to remove some items from the breakdown, if
they are not included in this pay period. 1. Choose Print Form from the File menu.

6. Goldenseal automatically calculates deductions, employer taxes,
benefits and vacations.

2. Enter Checking Transactions into the Transaction popup menu.
3. Enter Paycheck into the Form Type popup menu.

HINT: If you need control over the pay period or the wage rates that
are included, use the Write Payroll command (see page 342). 4. Choose the record range you’d like to print.

5. Click the Print button.

Payroll Adjustments
You can also print payroll records to give a breakdown of payroll
deductions, which you can use as an attachment when you don’t print
checks (or when you print on checks that don’t have room to show wages,
benefits and withholding).

You can also use simple payroll records to handle bonuses, pay
adjustments, vacation changes and tax payments, to enter payroll if you
are entering past paychecks, if you figure payroll deductions manually, or if
you use a payroll service but write your own paychecks. To do so, follow these steps:

1. Choose Print Form from the File menu.
To enter a payroll adjustment, follow these steps: 2. Enter Payroll Records into the Transaction popup menu.

1. Choose Payroll Records from the Costs menu. 3. Enter Employee Deductions into the Form Type popup menu.
2. Click the New button. 4. Choose the record range you’d like to print.

5. Click the Print button.

Vacations and Holidays
Goldenseal automatically keeps track of the accrued balance of vacations,
sick time and comp time for each employee. To view the current balance for
an employee, choose Employees from the Accounts menu, and find the
employee record.

HINT: Goldenseal automatically accrues vacation time during each pay
period. To adjust the balance, make a Payroll Record (see page 346).

If an employee gets a paid holiday, Goldenseal will remind you to create a
Labor Hours record for the holiday pay, if you haven’t already done that
when you use the Write Payroll command for that pay period.
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Payroll Reports The withholding report shows totals for each Tax Item for each employee.
To see an itemized list of withholdings, follow these steps:To see a report of employee hours, choose Payroll from the Reports menu,

and choose Employee Hours from the submenu. Enter a date range, and
click the Update button.

1. Turn on the More Details checkbox.
2. Turn off the Condensed checkbox.

You’ll see a list of Labor Hours records, grouped by employees. 3. Click the Update button.

To see employee withholding, choose Payroll from the Reports menu, and
choose Withholding by Employee from the submenu. Enter a date range,
and click the Update button.

To see a similar report listing totals for each tax, choose Payroll from the
Reports menu, and choose Withholding by Tax Item from the submenu.

For more about reports, see Lesson 20.

Finishing Up
This lesson has shown you how to write payroll each week.

Now that you’ve finished the easy part of payroll, you may feel ready to
re-hire the employees that you fired after the last lesson. Of course by now
they may have discovered the lucrative business of selling chic hats on the
Internet, and they may not want to come back.

HINT: Check out our optional Internet Chic Hat Sales Module if you
want to join your ex-employees in the lucrative business of selling chic
hats on the Internet
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Lesson Forty-Seven: Inventory Purchases
To purchase items for inventory, follow these steps:

Goldenseal keeps an inventory count for any Cost Items that you want to
track. You can also track inventory for Assemblies that you manufacture.

1. Choose Material Purchases from the Costs menu.
2. Click the New button.

Inventory counts increase automatically when you enter material purchases
with an item breakdown (see page 248). Inventory decreases when you
make sales with an item breakdown, or use inventory in projects.

3. Enter Items into the Breakdown popup field.
4. Enter supplier information.
5. Enter the items you are purchasing into the breakdown table.

You can also adjust inventory counts and value with Inventory Transfers. 6. Enter Inventory into the Job Class popup field.
7. Enter an Inventory account into the Job field.

Setting up for Inventory Goldenseal will automatically increase the inventory count of each item
you’ve purchased.To use Goldenseal for inventory tracking, create one or more Inventory

accounts (see page 214).
SalesTo track inventory quantities of a Cost Item, follow these steps:

To sell items from inventory, follow these steps:1. Choose Cost Items from the Costs menu.
1. Choose Sales from the Income menu.2. Find the item you want to track in inventory.
2. Click the New button.3. Turn on the Inventory checkbox.
3. Enter Items into the Breakdown popup field.HINT: If you want to inventory many items, use the Replace All

command to change them all at once (see Lesson 16). 4. Enter customer information.

If you manufacture items and then sell them, you can also track inventory
quantities for Assemblies (see Lesson 14).

5. Enter the items you are selling into the breakdown table.
6. Enter an Inventory account into the Inventory Account field.

Goldenseal will automatically decrease the inventory count of each item
you are selling.Inventory Valuation

Every Cost Item and Assembly includes a separate calculation for the
inventory value of that item. You’ll set the calculation method for it in the
Markup System for each item (see Lesson 13).

Inventory Use
To use inventory items on a project or as part of your overhead costs,
follow these steps:Use the Valuation field in each Inventory Account to set the value that

you’ll use to value inventory. The inventory value makes the most sense, but
you can also use the purchase price, resale price, or project price. 1. Choose Inventory Used from the Costs menu (see page 252).

2. Click the New button.

Inventory Aging
3. Enter Items into the Breakdown popup field.
4. Enter an inventory account into the Account field.

Use the Price Aging field in each Inventory account to set the way you’ll
handle the replacement of inventory. First In First Out (FIFO) means that
you will ‘rotate’ prices and sell old stock first. First In Last Out (FILO)
means that you’ll sell new stock first. Average All means that you’ll average
the price of new and old items each time you add new stock.

5. Enter the items you are using into the breakdown table.
6. Enter job cost information.

Goldenseal will automatically decrease the inventory count of each item
you’ve used. It also includes the items in job costs for the project.
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Inventory Transfers Shrinkage— reduce inventory quantities due to losses of any kind. You
can allocate the value of the loss to any overhead account.Use Inventory transfers to make any kind of adjustment to inventory

quantity or value. Startup Stock— for inventory that exists when you first start using
Goldenseal. Its value is considered as starting equity.

To enter a transfer, follow these steps: HINT: If you don’t have time to enter all your startup stock when
you first use Goldenseal, that’s OK. Just run your business as usual,
and enter the original startup stock whenever you have time.

1. Choose Special Transfers from the Bank menu, and choose Inventory
Transfers from the submenu.

2. Click the New button.

Reconciling Inventory
To match computer inventory to actual inventory, follow these steps:

1. Choose Inventory from the Reports menu, and choose Item Count
Blank from the submenu.

2. Click the Update button, then click the Print button.
3. Take physical inventory, and fill in the actual quantity for each item.
4. If you need to make adjustments, enter Inventory Transfers.

Finding Shortages
To see a list of items that need to be ordered, choose Inventory from the
Reports menu, and choose Shortages Report from the submenu. Click the
Update button, and you’ll see a list of all material items that have
inventory counts that are smaller than the ‘reorder at’ amount.

Price Requests
3. Enter the type of transfer (see next page).
4. Enter information about a single item you are transferring, or enter

Items into the Breakdown popup field, and enter multiple items into
the table.

To request current prices from suppliers, follow these steps:

1. Choose Cost Items from the Costs menu.5. If the transfer reduces inventory in an account, enter a Take From
account. 2. Use the Find commands to find the items for which you want prices.

3. Choose Inventory from the Reports menu, and choose Price Request
Blank from the submenu.

6. If the transfer adds inventory to an account, enter an Add To account.

Transfer Types
4. Click the Update button, then click the Print button.

Finishing UpYou can make any of the following types of inventory transfers:

Transfer— move inventory from one account to another. Before you move on, you may want to take a break and brush up on your
juggling skills. Sure, you can already do three chain saws, but how about
three chain saws and a porcupine? Blindfolded?

Manufacture— create an assembly from its components. Goldenseal
will add to the quantity of the assembly, and reduce the quantity of
its components.

Yes, we know it’s hard to put a blindfold on a porcupine..Revalue— change the value of inventory.
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Lesson Forty-Eight: Taxes
Goldenseal includes special handling for four types of taxes:

Income Tax— You can allocate expenses and income to different
categories, so it’s easy to use your Goldenseal data to fill out tax
forms.

Payroll Tax— Goldenseal automatically withholds payroll taxes from
employees, and then pays withholding and employer taxes to tax
agencies or insurance companies when they are due.

Sales Tax— Goldenseal automatically charges sales tax on sales or
project billing, and pays it automatically to sales tax agencies.

Vendor Withholding— Goldenseal allows you to withhold backup
withholding or other taxes from suppliers and subcontractors.

This lesson explains how to use Goldenseal for each type of tax.

Income Taxes— Cash Basis
If you use cash accounting for tax purposes, the easiest way to classify
your income and expenses is to use the Tax Class field, which is found in
every bank transaction. 4. If you’d like to get the report data into a spreadsheet, click the Save

As Text button.
Goldenseal groups expenses into the five basic cost areas (equipment,
labor, materials, subcontractors, other costs), plus a few other categories
such as bank fees and interest paid. It groups income into project income,
rentals and sales, plus a few minor categories such as bank interest.

HINT: The Income Tax Report shows all bank transactions. You
won’t include bank transfers on the income tax form, since they only
shift funds and are neither income nor expense. You may also have
other income or expense transactions that don't belong on your tax
form for some reason.To put expenses from a vendor into a different category, follow these steps:

Income Taxes— Accrual Basis
1. Choose Material Suppliers, Subcontractors or Other Costs from the

Accounts menu.
2. Find the account you’d like to change. If you use accrual accounting for tax purposes, you can probably still use

the Income Tax Report to prepare taxes. Start with the cash numbers, and
then make any adjustments for accrual conditions.

3. Enter a cost category into the Income Tax Class field.

To see a report of all financial transactions broken down by tax class,
follow these steps: For example, you may need to adjust the following expenses for the year in

which they accrue:1. Choose Taxes from the Reports menu, and choose Income Tax Report
from the submenu. • Prepaid expenses such as insurance

2. Use the Date Range popup field to enter a date range. • Accounts payable in the last month of the fiscal year
3. Click the Update button. • Paychecks at the end of the fiscal year

• Payroll taxes that you collect in one year and pay in another
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You also may need to adjust the following income amounts for the year in
which they accrue:

Payroll Tax Setup
Create a Other Cost account for each tax agency, and for any insurance
agencies that collect payroll-based insurance.• Projects that are partly-complete at the close of the fiscal year

• Sales that have not yet been paid To do so, follow these steps:
• Write-offs that you’ve taken via Payment Receipts that use a write-off

as the payment method. 1. Choose Other Costs from the Accounts menu.
2. Click the New button.

For a report of all expenses accrued during a time period, follow these
steps: 3. Enter details for the account (see page 228).

To assign taxes to a tax agency, follow these steps:1. Choose Expenses from the Reports menu, and choose All Expenses
from the submenu. 1. Choose Payroll Setup from the Costs menu, and choose Tax Items

from the submenu.2. Enter a date range.
2. Double-click on an item.3. Click the Update button.
3. Enter the tax agency into the Pay To Account field.For a report of sales income during a time period, follow these steps:
4. Click OK.

1. Choose Income from the Reports menu, and choose Sales from the
submenu. 5. Repeat steps 2 to 4 for each Tax Item.

Paying Payroll Taxes
2. Enter a date range.
3. Click the Update button.

To pay payroll taxes to a tax agency, follow these steps:For a report of project accrued income during a time period, follow these
steps: 1. Choose Pay Bills from the Bank menu.

2. Click in the popup field at upper right, and choose Payroll Taxes as
the item to pay.

1. Choose Projects from the Reports menu, and choose Project Bills from
the submenu.

2. Enter a date range.
3. Click the Update button.

Payroll Taxes
When you use the Write Payroll command, Goldenseal automatically
calculates tax withholding and employer taxes, and ‘posts’ each deduction
and employer tax item to the account that receives payment for the tax.

NOTE: Before you write payroll, you’ll need to assign each Tax Item to
a tax agency so it will post properly (see page 357).

When tax payments come due, you can easily use the Pay Bills command to
pay those taxes to each tax agency.

NOTE: Goldenseal also prints W-2 forms for employees. To do that,
choose Employees from the Accounts menu, then choose Print Forms
from the File menu and use the W-2 form.

3. You’ll see a list of tax agencies, with the amount due to each. Click in
the Pay column to mark the agencies that you want to pay now.

4. To see an itemized list of taxes due, double-click on the agency name.

Page 356 Lesson Forty-Eight Taxes Taxes Lesson Forty-Eight Page 357



5. You’ll see an itemized list of every payroll item due to this agency.

6. Click in the Pay column to set the items to include items in this
payment, then click OK to return to the main dialog.

7. To pay taxes, click the Create Checks button.
8. You’ll be asked how to pay for these items. Enter a bank account, or

leave the field blank if you plan to pay it later. Then click OK. To write a check to the tax agency, follow these steps:

1. Choose Pay Bills from the Bank menu.

Payroll Tax Payments
2. Choose All Other Costs in the vendor popup field at upper right.
3. Put a check mark next to the tax agency (and any other items you’d

like to pay now).When you use the Pay Bills command for tax payments, Goldenseal creates
an Other Cost record for each tax payment. It uses a Payroll Tax
breakdown to itemize every tax withholding item that is included in this
payment.

4. Click Write Checks.

You can also enter a single check to the tax agency, as follows:

1. Choose Checking Transactions from the Bank menu, and choose a
bank account from the submenu.

HINT: When you create a tax payment, Goldenseal automatically
‘posts’ the payment of each individual withholding item, so they won’t
ever show up in the Pay Bills command again. 2. Click the New button.

3. Enter Other Cost into the Pay To field, and the tax agency into the
Account field.

To view tax payments, follow these steps:

1. Choose Other Costs from the Costs menu. 4. Enter Other Cost into the Transaction Paid field.
2. Use the browser controls or the Find command to locate a specific

payment (see the next page).
5. Enter the tax payment transaction into the Reference field.
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Payroll Tax Reports Sales Taxes and GST Taxes
After you’ve made a payroll tax payment, you can get a report of the tax
payment in a form that is more useful for filling out tax forms.

When you enter sales and project bills, Goldenseal automatically ‘posts’ the
tax amount to the account for the agency that receives the sales tax.

To do so, follow these steps: When tax payments are due, you can easily pay those taxes to each tax
agency.1. Choose Taxes from the Reports menu, and choose Tax Payment By

Tax from the submenu.

Sales Tax Setup2. Enter an Other Cost record into the Other Cost field.
3. Click the Update button. Before you collect sales tax, create an account for each sales tax agency. To

do so, follow these steps:

1. Choose Other Costs from the Accounts menu.
2. Click the New button.
3. Enter details for the account (see page 228).

Create a separate sales tax rate for each municipality for which you collect
taxes. To do so, follow these steps:

1. Choose Income Setup from the Income menu, and choose Sales Tax
from the submenu.

2. Click the New button.
3. Enter details for the tax rate (see page 233).
4. Enter the tax agency into the Paid To Account field.
5. Click OK.
6. Repeat steps 2 to 5 for each separate tax rate that you collect.

If you collect GST tax and also get a credit for GST taxes that you pay to
vendors, you'll also set up a Vendor Withholding credit to handle the credit
portion of the tax (see page 364).

Charging Sales Tax and GST Tax
To charge sales tax, follow these steps:4. You’ll see a report listing each tax paid, with the amount paid for each

employee. 1. Enter a sales transaction (see page 292) or a project bill (see Lesson
43).To see a breakdown of the individual tax items paid for each employee,

follow these steps: 2. Enter a sales tax rate into the Tax Rate field.
3. Goldenseal automatically computes the tax amount, and adds it to

the amount due to the tax agency.
1. Turn on the More Details checkbox.
2. Turn off the Condensed checkbox.
3. Click the Update button.
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Paying Sales Taxes Sales Tax Payments
To pay sales tax or GST Tax to a tax agency, follow these steps: When you use the Pay Bills command for sales tax payments, Goldenseal

creates an Other Cost record for each tax payment. It uses a Sales Tax
breakdown to itemize every sale or project bill included in this payment.

1. Choose Pay Bills from the Bank menu.
2. Click in the popup field at upper right, and choose Sales Tax as the

item to pay. To view tax payments, follow these steps:

1. Choose Other Costs from the Costs menu.
2. Use the browser controls or the Find command to locate a specific

payment.

Sales tax payments are very similar to payroll tax payments (see pages 360
to 361).

Sales Tax Reports
After you’ve made a sales tax payment, you can get a report of the tax
payment in a form that is more useful for filling out tax forms. To do so,
follow these steps:

3. You’ll see a list of all tax agencies with sales tax due.
1. Choose Taxes from the Reports menu, and choose Sales Tax Payment

from the submenu.4. To see an itemized list of taxes due, double-click on the agency name.

2. Enter an Other Cost record into the Other Cost field.
3. Click the Update button.

5. You’ll see an itemized list of every tax item due to this agency.
6. Click in the Pay column to set the items to include items in this

payment, then click OK to return to the main dialog.
To see a breakdown of the individual sales, follow these steps:

1. Turn on the More Details checkbox.7. To pay taxes, click the Create Checks button.
2. Turn off the Condensed checkbox.8. You’ll be asked how to pay for these items. Enter a bank account, or

leave the field blank if you plan to pay it later. Then click OK. 3. Click the Update button.
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Vendor Withholding and GST Credit 2. Click in the popup field at upper right, and choose Vendor
Withholding as the item to pay.Use vendor withholding for taxes that you deduct from vendors and

subcontractors. It also handles the credit on GST taxes paid on expenses in
Canada and other countries.

3. You’ll see a list of all tax agencies with withholding payments due.
4. To see an itemized list of taxes due, double-click on the agency name.
5. You’ll see an itemized list of every withholding item due to this

agency.
Vendor Withholding Setup 6. Click in the Pay column to set the items to include items in this

payment, then click OK to return to the main dialog.Before you collect vendor withholding, create an account for each tax
agency that receives payments. To do so, follow these steps: 7. To pay taxes, click the Create Checks button.

1. Choose Other Costs from the Accounts menu. 8. You’ll be asked how to pay for these items. Enter a bank account, or
leave the field blank if you plan to pay it later. Then click OK.2. Click the New button.

Vendor Withholding Reports
3. Enter details for the account (see page 228).

Create vendor withholding rates for each tax that you withhold. To do so,
follow these steps: After you’ve made a withholding payment, you can get a report of the

payment in a form that is more useful for filling out tax forms.1. Choose Cost Setup from the Costs menu, and choose Vendor
Withholding from the submenu. To do so, follow these steps:

2. Click the New button.
1. Choose Taxes from the Reports menu, and choose Tax Payment By

Tax from the submenu.3. Enter details for the tax rate (which may be a credit for GST).
4. Enter the tax agency into the Paid To Account field. 2. Enter an Other Cost record into the Other Cost field.
5. Click OK. 3. Click the Update button.
6. Repeat steps 2 to 5 for each separate tax rate that you collect.

Finishing Up
Charging Vendor Withholding

This lesson has explained how to work with taxes, and how to get those
tax payments into the mail with a minimum of hassle.To charge vendor withholding, follow these steps:

1. Enter a material purchase (see page 238), a subcontractor cost (see
page 253) or an other cost transaction (see page 255). As we all know, taxes are a beneficial thing, and if it weren’t for taxes like

the Texas Text Tax and the Tennessee Tropical Trinket Transfer Tax, all
government action would grind to a halt, chlorophyll would stop
synthesizing, and life on this planet would soon cease to exist.

2. Enter a vendor withholding rate into the Withholding field.
3. Goldenseal automatically computes the withholding amount, adjusts

the amount of the purchase, and adds the tax or subtracts the credit
due to the tax agency . However, we would like to point out that not all taxes are good. For

example, a federal Chic Hat Tax is in legislative committee at the House
and Senate at this very moment.

Paying Vendor Withholding This short-sighted act is the work of the powerful scalp-sunscreen lobby,
and it will only drive chic-hat purchasers to cross the borders into Canada,
France and Mexico for their hat purchases. It will also cause serious
economic harm to our embattled wax fruit and duct tape industries.

To pay vendor withholding to a tax agency or calculate a GST credit,
follow these steps:

1. Choose Pay Bills from the Bank menu.
We urge you to contact your senators and representatives immediately!
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Lesson Forty-Nine: Special Transfers Cash Transfers
Use cash transfers to handle any transfer of funds that can’t be handled
through an ordinary business transaction. A cash transfer does not affect
accounts payable, billing or job costs. All it does is subtract money from
one account’s balance, and add it to the balance of another.

Goldenseal includes several transfer transactions. Use them to handle
unusual situations, when you need to make adjustments that can’t be
handled by ordinary business transactions.

When to Use Cash TransfersAsset Transfers
Create a cash transfer to handle any unusual transaction that can’t be
handled with one of the other transactions in Goldenseal.Use asset transfers when you need to change the value of an asset because

of damage, improvements or changing markets, or when you sell an asset.
Cash transfers are most often used to transfer funds between Utility
accounts, if you’ve set up a ‘classic’ set of bookkeeping accounts. You can
also involve project and overhead accounts in cash transfers.

NOTE: When you purchase an asset, simply create an Equipment or
Real Estate account, and enter the starting value.

To create an asset transfer, follow these steps: NOTE: To transfer cash to or from a cash account or a bank account,
create a bank transaction and use Transfer In or Transfer Out as a
transaction type (see page 274).

1. Choose Special Transfers from the Bank menu, then choose Assets
Transfers from the submenu.

2. Click the New button.

Creating a Cash Transfer
To create a cash transfer, follow these steps:

1. Choose Special Transfers from the Bank menu, then choose Cash
Transfers from the submenu.

2. Click the New button.

3. Enter the type of adjustment, the asset account whose value has
changed, and the amount of the adjustment.

4. Enter the account that will be charged with the amount of the value
change.

3. Enter the accounts involved in the transfer, and the amount of the
adjustment.
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Cost Transfers Lesson Fifty: Utility Accounts
Use cost transfers to adjust job costs. You can move costs from any job,
category and location to any other job, category and location. Utility accounts are ‘classic’ bookkeeping accounts. They represent abstract

accounting items that are not related to any specific person or business.NOTE: Cost transfers only affect job cost reports. They have no impact
on account balances, billing or accounts payable. Goldenseal uses Utility accounts ‘behind the scenes’ to manage some tasks.

You can also create your own utility accounts if you’d like to use ‘classic’
accounting within Goldenseal.When to Use Cost Transfers

Use cost transfers whenever you need to adjust job costs in one or more
jobs. You might use them to fix data entry errors, or to account for work
done on one job that really should be costed to another. You can also use
them for project job costs from before you started using Goldenseal.

HINT: Even if you never look at them, Utility accounts will still keep
Goldenseal’s accounting functions running smoothly.

Viewing Utility Accounts

Creating a Cost Transfer To view Utility accounts, follow these steps:

1. Choose Utility Accounts from the Accounts menu.To create a cost transfer, follow these steps:
2. You’ll see a browser window that shows all Utility accounts.1. Choose Special Transfers from the Bank menu, then choose Cost

Transfers from the submenu.
2. Click the New button.

Goldenseal uses each Utility account to store totals for a specific
accounting function. The utility account also keeps a list of transactions
that it can use to generate reports.

You can change the name of any utility account, and you can enter any
comments you have about it. You cannot change the reporting type or
current balance for any of the standard utility accounts that Goldenseal
starts out with. You also can’t change the basic function— Goldenseal will
continue to use the Unbilled Sales account to track billable sales, even if
you rename it to something else.

3. Enter the accounts involved in the transfer, and the amount of the
adjustment.
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New Utility Accounts Undeposited Funds— Money received but not yet deposited.
Unpaid Benefits, Taxes and Expense— Miscellaneous unpaid items.Goldenseal lets you create new utility accounts. You can move funds in and

out of them, the same as you would for ‘classic’ bookkeeping accounts. Utility— Other items that are not listed on the balance sheet.

Creating a New Utility Account
HINT: The only time you need to add utility accounts is if you prefer to
use a ‘classic’ accounting style, and want to create additional accounts
to itemize expenses, revenue or other items. To create a new utility account, follow these steps:

When to Use new Utility Accounts
1. Choose Utility Accounts from the Accounts menu.
2. Click the New button.

Create new utility accounts if you’d like to divide any of the basic
accounting functions between more than one account.

3. Enter a name for the new account, and choose a basic type of account
from the Reporting Type popup menu.

Using Utility Accounts
For example, you can create additional expense accounts to track expenses,
or new revenue accounts to track income.

HINT: Before you set up more utility accounts, consider using cost
categories, cost locations, job types or cost types as a way to allocate
income and expenses. They probably will accomplish the same thing,
and they are easier to use.

To use a new expense or revenue account, you’ll first need to set up the
layouts so you can show the utility account on data entry screens. Then you
can add it to reports.

For example, to add an Expense Account field to an expense transaction,
follow these steps:

Types of Utility Accounts
1. Choose Custom Layouts from the Options menu, then choose

Transactions from the submenu.Utility accounts can be of any of the following types:

Accounts Payable— Totals that you currently owe to suppliers and sub-
contractors.

2. You’ll see a window for changing layouts (see Lesson 32). Choose
Material Purchases from the Transaction popup menu.

Accounts Receivable— Totals for billed sales, billed projects, rents that are
due, and similar items.

3. Select the  Field tool from the palette at the left side of the
window (underneath the rounded rectangle).

Equity— The owner’s value in your business. Some equity accounts
handle the assets and liabilities that were put into your business upon
its creation, and some handle ongoing profits and losses.

HINT: When you single-click on a tool, it will be used only once.
After that, the selector tool (arrow) is restored. When you double-
click on a tool, it stays selected until you select a new tool.

NOTE: To set up owner equity that you want to track separately,
choose Liability Accounts from the Accounts menu, then choose
Owner Equity from the submenu.

4. Click in the layout at the place where you’d like the field to be, and
drag to the opposite corner.
HINT: You may need to enlarge the layout to fit the new field. To do
so, click on the lower right corner of the layout and drag, or choose
Size & Margins from the Options menu and enter larger numbers.

Expense— Totals for expenses of different types, either accrued (when
work is done) or cash (when the item is paid).

Misc. Assets— Other items considered as an asset on the balance sheet.
Misc. Liability— Other items considered as a liability on the balance

sheet.
Prepaid Expenses— Expenses that you have marked as prepaid.
Revenue— Totals for gross income from various sources, either accrued

(when work is done) or cash (when the item is paid).

Page 370 Lesson Fifty Utility Accounts Utility Accounts Lesson Fifty Page 371



Using Utility Accounts in Reports
To show totals for a new utility account in a report, first create a calculator
that uses the new account. To do so, follow these steps:

1. Choose Calculations from the Options menu, and choose Utility
Accounts from the submenu.

2. Click the New button.
3. Enter the new account into the Account field.
4. Enter the type of calculation into the Field field. For example, to get

totals during a time period from a new expense or revenue account,
choose Total In Date Range.

5. Click OK.

To use the new calculation in a report, follow these steps:

1. Choose Custom Layouts from the Options menu, and choose Reports
from the submenu.5. You’ll see a list of available fields. Choose Expense Account from the

list, and click OK. 2. Open the report where you’d like to show the account total.

Using New Expense Accounts
3. Click on the Calculator tool.
4. Click at one corner of where you’d like to show the field, and drag to

the opposite corner.Goldenseal starts out with five expense accounts for equipment, labor,
materials, subcontractors and other costs. Goldenseal automatically posts
equipment hours to the equipment expense account, material purchases to
the material expense account, and so on.

5. You’ll see a list of calculated fields. Enter Utility Accounts into the
popup menu at top, then choose the calculator you just created.

Utility Account LinksTo post expense transactions to a different expense account, enter the new
choice into the Expense Account field in the expense transaction.

Some Utility accounts ‘link’ to the transactions included in the account.

Using New Revenue Accounts For example, to see a list of billable Sales transactions that have not yet
been billed, follow these steps:

Goldenseal starts out with four basic revenue accounts— for sales, project
income, rentals and other income. 1. Choose Utility Accounts from the Accounts menu.

2. Use the Browser to get to the Unbilled Sales account (it’s the first
one).To post income transactions to a different revenue account, add the

Revenue Account field to the sales, rental transaction or billing records
layouts, and then enter a different revenue account.. 3. Choose Detail Transactions from the View menu.

Finishing UpUsing Cash Transfers
In a way, Utility accounts handle the ‘invisible’ money in your business.
And likewise, sometimes the most chic hats are the ones you can’t see.
Maybe that’s why there is so much interest in the new line of microscopic
‘nano-technology’ hats and garments in the latest Victoria’s Secret catalog.

You can also use cash transfers to move funds between utility accounts (see
page 367). The transfer will simply add to one account’s balance, and
subtract from the other’s.
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Lesson Fifty-One: Passwords
and Security

6. Use the slider controls to set the level of access to each part of the
company data.
HINT: If you hold down the Shift key when you move a control, all
the other controls in the same column will move to the same place.

Goldenseal includes a password protection system to control access from
each person who uses your company file. You can create a different level of
access for each employee.

7. When you are finished, click OK. You’ll need to confirm the password
as you leave.

Access LevelsThis lesson shows you how to create and use passwords, and how to use
the Audit Trail and other security features.

Four levels of access are available for data entry in each basic part of
Goldenseal:

Creating Passwords  No Access— The user will not be able to see or do anything.
To create a new password for someone who uses Goldenseal only to enter
payroll data, follow these steps:  View Access— The user can see records, but can’t create new records

or change existing ones.
1. Choose Passwords from the Options menu.

 Write Access— The user can create records or change existing records.2. You’ll see a list of passwords.
 Full Access— The user can create records or change existing records.
The user can also change print forms or data entry layouts.

3. Click the New button.
4. Enter the user’s name, or however you’d like to name the access level.

Three levels of access are available for reports:5. Enter the password that is used to enter this level. You can use any
text, numbers or punctuation, up to 31 characters. 

 No Access— The user will not be able to view any reports.

 Print Access— The user can view and print records.
 Full Access— The user can view and print reports. The user can also
change report layouts.

Four levels of access are available for passwords:

 No Access— The user will not be able to view or change any
passwords, including their own.

 Write Access— The user can view and change their own password.

 Full Write Access— The user can view and change their own
password, and passwords for any other users who have a lower level
of access.
 Full Access— The user can change any passwords.

The audit trail can bet set to No Access, View Access, or Full Access.

NOTE: Even with full access, you can only change comments in the
audit trail— all other fields are permanently locked.
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Master Password Choose the password level that applies to you, and enter the password.

There is always one master password which allows access to everything in
the program. You cannot delete the master password.

HINT: Goldenseal passwords are not case-sensitive. If your password
is ‘Gargoyle’, then you can type gargoyle or gArgOYLE.

If you enter your password incorrectly, you’ll be allowed a few more tries to
enter it correctly.

To assign a new password to the master password, follow these steps:

1. Choose Passwords from the Options menu.

Password Access
2. You’ll see a list of passwords.
3. Select Master Password from the list, and click the Edit button.
4. Type a password into the Password field. Some menu commands are not available to those whose password access is

not high enough. When you open an account or transaction window,
Goldenseal checks your password, and give you the type of access from the
Password list.

5. Click OK. You need to confirm the password as you leave.
WARNING: Don’t forget the master password! If you lose all full
access passwords, you may permanently lose access to your data.

No Access— no records will be visible.

Time Lockout Read Access— you can see records, but they are always locked and
can’t be changed.

Use time lockout to restrict access to records that are older than a certain
date. A user with a password that has a lockout will not be able to change
records that are older than the lockout date.

Data Entry or Full Access— you can see records, and you can change
them unless they are closed, or are older than the time lockout date.

If you are using passwords, Goldenseal displays your current level of
access on the left side of the browser window.NOTE: Time lockout applies only to users that have write access. If a

user has full access to a level, they’ll be able to change records no matter
how old they are (either the records or the user).

Password Hints
Using Passwords To be practical, passwords need to be simple enough so you can remember

them without writing them down. They also need to be complex enough
that someone else can’t deduce them.

When you first start with Goldenseal, it does not require passwords.
Anyone can do anything, anywhere in the program. If you don’t create any
passwords, that is how the program will remain. We suggest a nonsense phrase of items that only you know about (you have

23 characters to play with). For example, “garg19oyle flam87ingo”, which
is Turtle Creek’s founding year, favorite roof ornament and favorite bird.

HINT: If only one person uses the program, or if all users are trusted,
you can probably avoid using passwords. However you might still want
to use a password as protection from snoopy outsiders.

Deleting PasswordsOnce you have created new passwords, Goldenseal will ask you for a
password each time you open the company file. If you want to stop using a password, follow these steps:

1. Choose Passwords from the Options menu.
2. Click on the password you want to remove.
3. Click the Delete button.

If you remove all but the master password, Goldenseal will stop asking for
a password when you open the company file.
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Audit Trail You can use the Find command to locate specific types of records in the
Audit Trail window. For example, to find all transactions changed by a
specific employee, follow these steps:

The audit trail lets you see exactly what has been entered and changed in
the company file, and by whom. It is a record of everything important that
has happened within the company file. 1. Choose Find from the Edit menu.

2. Enter Transaction Changed into the Action Field, and enter the
employee’s password in the User field.

To set up the Audit Trail, follow these steps:

1. Choose Preferences from the Options menu, and choose Data Entry
from the submenu. 3. Click the Find button.

4. You will see a listing of all transactions changed with that password.2. Turn on the checkboxes for the actions you’d like to record.
Use the audit trail if you suspect dishonesty, if you want to find out the
person responsible for an error, or if you just want to see who has entered
what when.

HINT: The audit trail increases file size, and slows down the saving
of records slightly. If you don’t need it, turn off all the checkboxes for
audit trail actions.

HINT: To get full use of the audit trail, assign each employee a different
password, and keep them secure so one user can’t sign on with
another’s password.

To view the audit trail, follow these steps:

1. Choose Security from the View menu, then choose Audit Trail from the
submenu.

Verify File
HINT: You can only view the audit trail if you have signed on with a
password that gives you access to it (see Lesson 51).

On rare occasion, that data in your company file may become damaged due
to hardware, system or software errors. Use the Verify File command to
check the integrity of your company file. To verify, follow these steps:

1. Choose Security from the View menu, and choose Verify File from the
submenu.

2. Goldenseal will check every object in the company file (it may take a
few minutes, if you have a large number of records).

3. If there are any problems, Goldenseal will report them to you. It also
tells you the size of your data, and the amount of empty space in the
company file.

To repair any file damage, follow these steps:

1. Choose Export from the file menu, and choose Entire Company File
from the submenu.

2. Save the file on your hard drive.
3. Exit/Quit from Goldenseal.
4. Reopen Goldenseal, and create a new (empty) company file.

2. You’ll see a standard browser window. Each record shows one action
that happened with the company file.

5. Choose Import from the File menu, and choose Company File from the
submenu.

HINT: To see the actual transaction record shown in an audit trail
record, choose Detail Transaction from the View menu.

6. Select the file that you exported in step 2. Goldenseal will import all
of your company data, and ‘tidy up’ any problems that it finds.
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Compress File
To compress your company file so it takes up less space, follow these
steps:

1. Make a backup copy of your file (see Lesson 17).
2. Choose Security from the View menu, and choose Compress File from

the submenu.
3. Goldenseal will rearrange the data in your company file so there is less

empty space.
HINT: Goldenseal is fairly efficient at managing empty space in the
file, so you probably will see only a small reduction in file size.

Database Report
To see the raw contents of your company file, follow these steps:

Other Security Reports
1. Choose Security from the View menu, and choose Database Report

from the submenu.
To see the records that are currently ‘cached’ in RAM, choose Security from
the View menu, and choose Cache Report from the submenu. You can also
choose Clear Memory Cache to remove items from the cache. The only items
that should remain are records that are currently visible in a browser
window, and possibly a few support objects.

To see the records in your company file in the order they are stored on disk,
choose Security from the View menu, and choose File Order Report from the
submenu.

Finishing Up
In this lesson you have learned how to create passwords, check the audit
trail, and use other security features in Goldenseal.

Did you know that over 35% of computer users use the name of their pet as
a password? Another 12% use the word “gargoyle”, and 9% use the word
“flamingo”. Then again, 7% of computer users have a pet flamingo named
Gargoyle, and another 14% have a pet gargoyle named Flamingo.

2. You’ll see a list of all record classes currently stored in Goldenseal,
with the number of records in each.

Did you know that over 23% of computer software manuals include fake
statistics? Here at Turtle Creek, well over 142% of us are shocked,
positively shocked, by such statistics.

3. To see specific records in a class, double-click on a row.
4. You’ll see a list of all records in that class. Goldenseal lists technical

information such as the object ID, the current location in RAM, the
location on disk, and the object size.

5. To see the raw data stored in a single record, double-click on its row.
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Lesson Fifty-Two: Financial Reports Income Statement
The income statement shows you a compact listing of your income and
expenses. It’s a good way to see how profitable your business is.Goldenseal includes a variety of reports that show you valuable infor-

mation about your business. Reports are a useful management tool. To see an income statement, choose Financials from the Reports menu, then
choose Income Statement from the submenu.Lesson 20 explains how to use the basic Reports window. This lesson

covers some additional reports used for accounting and finances.

Balance Sheet
The balance sheet shows you a compact listing of your assets, liabilities
and net worth. It’s a good way to see how solvent your business is.

To see a balance sheet report, choose Financials from the Reports menu,
then choose Balance Sheet from the submenu.

The Income Statement gets all income values within the date range that is
specified in the Date Range field. To see income and expenses for a
different period, change the Date Range popup field (see Lesson 20).

The Cash figures are based on bank transactions, and the Accrued
transactions are based on expense transactions and income transactions
(sales, project billing and rental transactions).

HINT: If you only want to use the cash or accrued values, you can use
the Custom Layouts command to remove some of the fields from this
report (see Lesson 21).

Click the Update button to have Goldenseal fill in the most recent values.
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Material Purchases Report Job Cost Reports
To see a list of material purchases, follow these steps: Goldenseal includes several reports that show job costs for your projects.

1. Choose Expenses from the Reports menu, then choose Material
Purchases from the submenu.

HINT: For a quick snapshot of job costs, you can also use the Job Costs
command (see Lesson 39).

2. Click the Update button.. To see a category breakdown of estimated versus actual costs, follow these
steps:

1. Choose Projects from the Reports menu, and choose Costs by
Category from the submenu.

2. Enter a project into the Project Account field.
3. Click the Update button.

3. You’ll see the standard report, which is a simple list of all material
purchases.

4. Use the scroll control to view all of the items in the report.
5. To see more detail about a purchase, double-click on its row.

Goldenseal will open a regular browser window for the purchase that
is listed in that row. It shows you everything about the purchase. If
the transaction has not been closed, you can make changes to it.

4. You’ll see a report of estimated and actual costs for each category.

You can also choose the following reports in the Projects menu:

Costs by Class— Estimated versus actual, by class and category.
HINT: Sometimes a report is the fastest way to locate a specific
transaction.

Costs by Subcategory— Estimated versus actual, by category and
subcategory (if subcategories are available in the project).

You can use the Date Range field and the Item Range field to limit the
purchases that you see in the report. You can also use breakdowns to group
purchases by supplier, job, status or other fields (see Lesson 20).

Costs by Location— Estimated versus actual by location.
Itemized Costs— Actual expenses, listed individually and grouped by

category and subcategory.
HINT: Many other reports also show a list of transactions, similar to
the Material Purchases report..

Itemized Estimate— Estimated expenses, listed individually and
grouped by category and subcategory.

 Page 384 Lesson Fifty-Two Financial Reports Financial Reports Lesson Fifty-Two Page 385



Other Reports Lesson Fifty-Three: Calculators
There are more than eighty reports available under the Reports menu.

Calculators fetch a value or a list of values from accounts, lists or
transactions. Use them when you want to show a single value or a short list
of items. Calculators can also add multiple items and do other math.

Other parts of this manual have already covered some of the other reports,
including the following:

Contact Log report (see Lesson 20)
In this Lesson you will make a calculator that shows the average contract
price for projects. To do that will require three calculators.

Material Takeoff report (see Lesson 8)
Schedule report (see Lesson 20)

Total Amount for All Projects
Tool report (see Lesson 20)
Itemized Estimates (see Lesson 20)
Income Tax report (see page 354) To create a calculator that displays the total contract amount for all pro-

jects, follow these steps:Payroll Tax report (see page 360)

Most of the remaining reports show accounts or transactions in a table,
similar to the Material Purchases report. A few use calculators, similar to
the Balance Sheet.

1. Choose Calculations from the Options menu, then choose Accounts
from the submenu.

2. You’ll see a list of calculators. Click the New button.
We can’t always think of every possible report that might be useful. If there
is something you’d like to see that is not already in a report, please contact
us with your ideas! We will work it into a future version of Goldenseal.

3. Enter a name, and any comments you have.
4. Choose Projects from the Source popup menu.
5. Choose Contract Amount from the Field popup menu.

HINT: A sketch or sample of the report is most helpful to us. 6. Choose Sum as a Calculation Type.

More Ways to See Data
You can also use the ‘quick report’ commands to see a quick summary of
accounts payable (see Lesson 36), job costs (see Lesson 39), accounts
receivable (see Lesson 42), undeposited funds (see Lesson 44) and payroll
(see Lesson 46).

If you want to see all the data for accounts or transactions, you can also
use the Export command to create a text file with the contents of every
record and every field (see Lesson 25).

Finishing Up
This lesson has shown you how to view financial reports.

You might want to take a break now and do something you haven’t done
for a while. Do you have a musical instrument in the attic? Has it been
years since you played your air guitar? 7. Leave the other fields the same. When you have finished, click OK.
Of course it goes without saying that all those activities will be enhanced if
you also wear one of the chic hats from a previous lesson!
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Number of Projects 3. Enter a name, and any comments you have.
4. Enter Accounts for the First Source.To create a calculator that displays the number of projects, follow these

steps: 5. Enter the first calculator you made into the First Calculator field.
6. Enter Divide by Calculator into the Calculation Type field.1. If you closed the Account Calculation window, choose Calculations

from the Options menu, then choose Accounts from the submenu. 7. Enter Accounts for the Second Source.
8. Enter the second calculator you made into the Second Calculator field.2. Click the New button.

3. Enter a name, and any comments you have.
4. Choose Projects from the Source popup menu.
5. Choose Contract Amount from the Field popup menu.
6. Choose Count as a Calculation Type.

HINT: As you change the calculator, you’ll see the current value.

9. You can leave the other fields the same. When you have finished, click
OK.

10. To leave the list of calculators, click the Done button.

Using a Calculator
7. Leave the other fields the same. When you have finished, click OK.
8. Click the Close button to close the list of Account Calculations.

To use a calculator, add it to a report layout (see Lesson 22).

Average Contract Amount When you view that report via the Reports menu, the calculator will fill in a
value based on the current data in your company file, and the current
conditions you’ve entered at the top of the report window.

To create a calculator that computes the average contract price from the
two previous calculations, follow these steps:

1. Choose Calculations from the Options menu, then choose Custom
from the submenu.

2. You’ll see a list of custom calculators. Click the New button.
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Payroll Tax Calculator 5. Click in the layout at one corner of where you’d like the new field to be
located, and drag to the opposite corner.Goldenseal provides special calculators for payroll taxes. You can assign

them to wage rates, tax items or benefit items. They will calculate totals for
an employee, and fill in a number for W-2 and other payroll reports.

To create a new payroll tax report field, follow these steps:

1. Choose Payroll Setup from the Costs menu, then choose Tax Report
Fields from the submenu.

2. Click the New button.

6. You’ll see a dialog to choose a calculated field. Choose Payroll Tax
Fields in the Calculation Type popup menu— Goldenseal will show
you a list of all tax report fields.

7. Choose a tax report field from the list, then click OK.
8. The tax report field will be added to the layout at the selected

location.
3. Enter a name for the tax report field. You can also enter a brief

description for it.
4. Enter calculation details.
5. If this item takes values for certain taxes, benefits or wage rates, enter

them into the Items Included table.
6. Click OK.

Using in Reports
To use a tax report field in a payroll report, follow these steps:

1. Choose Custom Layouts from the Options menu, then choose Reports
from the submenu.

2. Enter Payroll into the Area popup menu at the upper right corner of
the window.

3. Choose a report from the Report popup menu.
4. Click on the Calculator tool (beneath the Oval tool).

Page 390 Lesson Fifty-Three Calculators Calculators Lesson Fifty-Three Page 391



Other Calculators
Goldenseal includes several other classes of calculators that you can use to
put custom values into reports and printed forms.

(this page is intentionally blank)

Use any of the following:

Breakdown Calculations— Get values from transaction breakdown
items.

List Calculations— Get values from list records.
Transaction Calculations— Get values from any class of transaction.
Income Tax Calculations— Calculated values for income tax reports,

(similar to payroll tax calculators).
Utility Account Calculators— Get values from utility accounts.

EXAMPLE: Most of the calculators in the Income Statement are
Utility Account calculators.

Some calculators also fill in Dimension values for your estimates— those
have already been covered in Lesson 23.

Finishing Up
This is the last Lesson. You’re done! You now know everything you might
ever need to know about Goldenseal, chic hats, gargoyles, duct tape, and
even about life.

NOTE: And you probably thought Goldenseal was just an estimating
and accounting program.

Now is definitely a good time for a break. Maybe it’s even time for a
vacation.

Have you ever thought about someplace exotic?

How about Tuva, in the center of Asia, where the musical instruments are
all made from horse body parts and people throat-sing? Not a McDonald’s
within a thousand miles.

Or then again, you might prefer the Mall of the Millennium in Mormolu,
Missouri. Five McDonald’s all under one roof, and free souvenir glasses for
anyone who eats at all five in a single day.
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Getting
Started on
Your Own

Owner Equity
If you have a sole proprietorship, or if only one person owns your entire
company, you can skip this section.

To set up ownership shares in Goldenseal when more than one person owns
a share of the business, follow these steps:

1. Choose Other Lists from the Options menu, then choose Owners from
the submenu.

Now that you have completed the ABC’s of Goldenseal, you are ready to
start using it to run your own company. 2. Select an existing owner and click Edit, or click the New button.

To do so, follow these steps:

1. Open one of the Starter Files.
2. Import data from your existing records.
3. (Optional) import Goldenseal data for payroll or unit costs.
4. Set up lists, category systems and other basic information.
5. Start creating transaction records.

Check the Getting Started On Your Own section in the Goldenseal
Estimating manual for some setup hints. This section covers some
additional setup items that apply only to the accounting portions of
Goldenseal.

Account Setup
You'll need to set up some accounts before you can enter any business
records into Goldenseal. Most people enter just the accounts that the need
for their first few transactions, and then keep entering accounts as they
need them.

3. Enter information about the owner (a person, partnership or
corporation).

4. Click OK.HINT: After a month or two, you won't need to spend so much time
setting up! 5. Repeat steps 2 to 4 for each owner. When you are finished, click the

Done button.
If you already have data in Quicken or QuickBooks, you can export your
data from those programs and then import accounts and lists into
Goldenseal. For more about that, check our website at www.turtlesoft.com
(click the Site Map button, then click the QuickBooks link).

To allocate ownership shares, follow these steps:

1. Choose Liability Accounts from the Accounts menu, then choose
Owner Equity from the submenu.

2. Click the New button.If you already have data in another program, you can probably import your
data into Goldenseal so you don't have to retype everything. See Lesson 25
in the Getting Started with Estimating manual for more about importing.
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4. Open either the Canada Payroll folder or the US Payroll folder, and
then select the file for your state or province.

5. Goldenseal will load in the tax tables for your state.

Updating from our Website
To load the latest state payroll from our website, follow these steps:

1. Click on the Start button, and choose Programs from the menu.
2. Select Internet Explorer or some other web browser.
3. Go to http://www.turtlesoft.com.
4. Click the Users button at the top of the window.
5. Click on the link to the current state payroll files.
6. Goldenseal will save a compressed .zip file onto your hard drive. You

can save the file in the My Documents folder, or anywhere else on
your hard drive.

7. Double-click on the .zip file to decompress it.3. Enter the first owner into the first row of the Owner breakdown table.
Also enter their percentage of ownership. To import the latest state payroll into your company file, follow these

steps:4. Press the Return key, and enter the next owner and their percentage.
5. Repeat step 4 until all owners are entered. 1. Open your company file.
6. If you use more than one way to divide profits or ownership, click the

New button, and repeat steps 3 to 5.
2. Choose Import from the File menu, and choose Payroll Update from

the submenu.
NOTE: Goldenseal 1.0 does not track equity for multiple owners, but
that feature will be added in a later upgrade.

3. You'll see a 'file navigation' dialog to choose a file. Go to the same
location where you saved the download file, open the payroll folder,
and select the file for your state or province.

Payroll Setup
4. Goldenseal will load in the tax tables for your state.

Viewing Payroll InfoGoldenseal includes payroll withholding tables for all US states and
Canadian provinces. You can install them from the program CD, or
download them from our website at the beginning of each new year (there is
no charge for this service).

To see the imported tax info for your state, follow these steps:

1. Open your company file.
2. Choose Payroll Setup from the Costs menu, and choose Tax Items

from the submenu.
To import state payroll from the CD, follow these steps:

1. Open your company file. 3. You should see one or more tax items for your state or province.
2. Choose Import from the File menu, and choose Payroll Update from

the submenu. For info about starting payroll in mid-year, see page 402.

3. You'll see a 'file navigation' dialog to choose a file. Select your Local
Disk (C:/ drive), then open the Program Files folder, then open the
Goldenseal folder, then open the Payroll Files folder.
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Entering Records Projects
A good way to start entering project data into Goldenseal is as follows:

Once you have set up accounts and lists, you can start entering business
transactions into Goldenseal.

1. Set up customer accounts for the people paying for project work.
2. Set up an estimate for each project that has a budget.
3. Set up project accounts.

Where To Start 4. Enter lists— project payment terms, draw schedules, and other
choices under the Income Setup command.

You skip any parts of Goldenseal that don’t apply to your business, and
you can start with whatever is most convenient or most urgent.

5. If you want to track job costs or do time and materials billing, set up
cost accounts (equipment, material, subcontractor and other cost) and
cost categories, and then start entering expenses and labor hours (see
the previous two sections).

The following sections describe the most convenient way to start with each
part of MacNail.

6. To make draw schedule or progress payment bills, use the Billing
commands.Expenses

7. To track project logistics, enter Project Log, Punch List, Change
Orders, Appointment, and Transmittal records.A good way to start entering expenses into Goldenseal is as follows:

1. Set up cost accounts— equipment, material, subcontractor and other
cost accounts. Sales

2. Set up the bank accounts that you use to pay for expenses. A good way to start entering sale data into Goldenseal is as follows:
3. If you want to track job costs right away, set up job accounts

(customers, overhead and projects) and cost categories. 1. Set up customer accounts for each of your customers.
2. Enter lists— job sales tax, delivery methods, discounts, customer

payment terms, and other choices under the Income Setup command.
4. Enter lists— vendor sales tax and vendor payment terms.
4. Start entering expense transactions— equipment hours, material pur-

chases, subcontractor bills and other cost transactions. 3. Start entering sales.
4. Use the Deposit Funds command to deposit sales income.5. Use the Pay Bills command to pay vendor bills, as they come due.

RentalsPayroll
A good way to start entering rental data into Goldenseal is as follows:A good way to start entering payroll costs into Goldenseal is as follows:

1. Set up customer accounts for each of your tenants.1. Set up employee accounts.
2. Set up Real Estate accounts for each of your properties.2. Enter lists— wage rates, tax items, tax packages, benefit items, benefit

packages, and other items under the Payroll Setup command. 3. Enter rental payment terms.
4. Create Lease transactions for each tenant.3. Set up the bank accounts that you use for writing paychecks.
5. Start entering Rental Transactions.4. If you want to track job costs right away, set up job accounts

(customers, overhead and projects) and cost categories.
5. Enter employee hours.
6. Use the Write Payroll command to handle payroll.
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When To Start with Goldenseal
You can start using Goldenseal at any time.

Starting Date
Pick a day when you will officially start using Goldenseal.

You may want to start at the beginning of a year, quarter or month, but
there is no requirement that you do so.

Starting Balances
Enter your best estimate of the starting balance for each bank account— the
amount that is in the account on the day when you start using Goldenseal.

When you get your next bank statement, you can reconcile the account, and
adjust the starting balance or ‘trial balance’ if needed.

Prior Job Costs
If you have projects underway when you start using Goldenseal, you can
enter prior job cost information for them. That allows you to get a more
accurate picture of the total project cost. 6. Enter specific costs into the breakdown table.

Prior Project IncomeTo include prior expenses, enter them into expense transactions (Equipment
Log, Labor Log, Purchases, Subcontractor Bills, Other Costs). Use Job Cost
Only as a status. Goldenseal will use the cost information for job costing,
but it will not affect Accounts Payable.

To include prior project income, enter payments amounts into Bank
Deposit transactions, and use Job Cost Only as a status. Goldenseal will
credit the income to the job, but it won’t affect the account balance.

HINT: You can enter estimated costs, if you don’t know the exact
amounts.

You can also use a Cost Transfer to enter costs that you have already spent
on a project. To do so, follow these steps:

1. Choose Special Transfers from the Accounts menu, then choose Cost
Transfers from the submenu.

2. Click the New button.
3. Enter Prior Costs into the Transfer Type popup menu.
4. Enter the project into the Move To fields.
5. To enter multiple costs at one time, enter Category into the Breakdown

popup menu (or enter Items if you want to enter specific cost items).
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Mid-Year Payroll withholding amounts. Click in the Amount column and type in the
amount you actually withheld.

When you start in the middle of the year, there are three ways to handle
payroll— you can go back and enter all payroll hours starting at the first of
the year, you can ‘cheat’ and enter year-to-date totals directly into a single
record, or you can just start at mid-year and ignore year-to-date amounts.

9. Repeat step 8 for employer taxes, category taxes and benefits.
10. Repeat steps 7 to 9 for each employee.
11. Repeat steps 2 to 10 for each pay period.

NOTE: If any taxes or wage rates changed during the year, make the
change when you get to the appropriate pay period.Getting Started

Entering Combined Year-To-Date Amounts
Before you enter previous payroll, follow these steps so you can change
payroll withholding amounts to match what you actually deducted:

A quicker way to enter mid-year payroll is to put all year-to-date totals
into a single payroll record.

1. Choose Preferences from the Options menu, and choose Expenses
from the submenu.

To do so, follow these steps:2. Turn on the Allow Payroll Deduction Changes checkbox.
3. Click OK. 1. Set up payroll deductions, wage rates and other payroll information

for each employee (see Lesson 28).
Entering All Hours 2. Create a Labor Hours record for each employee. Enter the total

number of hours they worked— starting in the first pay period with a
payday in the current year, and ending in the last pay period before
you start using Goldenseal. If the employee worked at more than one
wage rate, enter multiple records, and enter the hours they worked at
each rate.

The most accurate way to start payroll in mid-year is to enter information
right from the first of the year. That will also give you more accurate job
cost information.

To do so, follow these steps:

1. Set up payroll deductions, wage rates and other payroll information
for each employee (see Lesson 45). If an employee’s status changed
during the year, start out with their setup from the first of the year.

3. Choose Payroll Records from the Costs menu.
4. Click the New button.
5. Enter an employee into the Employee field.

2. Choose Labor Hours from the Costs menu. 6. Choose YTD Only from the Status popup menu.
3. Click the New button, and enter hours from the first pay period for

each employee.
7. Choose Wages from the Breakdown popup menu. Goldenseal will

show you the year-to-date gross wages for the employee.
HINT: You may need to create several records, if the employee
worked on more than one job during the pay period.

8. Adjust the overtime amount so the total wages are correct.
9. Choose Deductions from the Breakdown popup menu. You’ll see a list

of employee withholding items.4. Choose Write Payroll from the Costs menu. Goldenseal will show you
the computed wages and deductions (see Lesson 46). They may not
be correct, but for now you can ignore any differences. 10. If the calculated deductions are not correct, enter the correct year-to-

date figures for each deduction into the Amount column.
5. Click the Write Payroll button. Don’t enter a bank account, so

Goldenseal will skip the actual paychecks. HINT: It’s normal for most taxes to be calculated incorrectly when you
do a whole year at once, since the wage brackets are thrown off when
you combine pay periods.6. Goldenseal will create a payroll record for each employee.

7. In the payroll record, choose Wages from the Breakdown popup menu.
You can adjust overtime hours if needed.

11. Choose Employer Taxes from the Breakdown popup menu, and fill in
year-to-date figures for employer taxes.

8. Choose Deductions from the Breakdown popup menu. If you used the
‘lookup tables’ in the tax table, you’ll probably need to change the

12. If you calculate some taxes based on the work being done, choose
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Category Taxes from the Breakdown popup menu and fill in year-to-
date amounts.

13. Choose Benefits from the Breakdown popup menu and fill in year-to-
date amounts.

14. Repeat steps 4 to 13 for each employee.

Ignoring Payroll Year-To-Date
The easiest way to start payroll in mid-year is to just start, and ignore
year-to-date totals. You may want to consider doing that if you are starting
very late in the year.

To do so, follow these steps:

1. Set up the current payroll deductions, wage rates and other payroll
information for each employee (see Lesson 28)

2. Choose Labor Hours from the Costs menu.
3. Click the New button, and enter hours for the current pay period for

each employee (see Lesson 29).
4. Choose Write Payroll from the Costs menu. Check the figures, and

then click the Write Payroll button to create payroll records.
5. If there is withholding or employer taxes that ‘cut off’ at a certain

amount, you’ll need to adjust the deduction amounts if they are
currently over the limit.

Index
The Index for this manual is located in the back of the Estimating manual
(to make searches easier, the index covers both manuals together.)
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